Software Solutions

ASG-Encore™
Installation Guide

Version 7.0
Publication Number: ENX0300-70
Publication Date: February 2003

The information contained herein is the confidential and proprietary information of Allen Systems Group, Inc. Unauthorized use of this information and disclosure to
third parties is expressly prohibited. This technical publication may not be reproduced in whole or in part, by any means, without the express written consent of Allen
Systems Group, Inc.

© 2003 Allen Systems Group, Inc. All rights reserved.
All names and products contained herein are the trademarks or registered trademarks of their respective holders.

ASG Worldwide Headquarters Naples Florida USA | asg.com | info@asg.com
1333 Third Avenue South, Naples, Florida 34102 USA Tel: 941.435.2200 Fax: 941.263.3692 Toll Free: 800.932.5536 (USA only)






Contents

Preface . ... coviiiiiiiiiiiiiiiiiiii ittt teesens iii
About this Publication ............cciitiiiiiiiiiiiiiiiiiiiiinrecnnnennns iii
Related Publications . .......ccitiiiiii ittt iiiiiiiieneenenecnennns iv
ASG-Existing Systems Workbench (ASG-ESW). ...ttt v
Invoking ESW Products. .......ccciitiiiiiiiiiiiiieiineroeossensensonnss viii
ESW Product Integration. ..........c.iuiitiiiitiirnennrnerersnsessnsnnes ix
Example 1 ... .. e X
Example 2 ... xi
Publication Conventions. . ........coitiiiiiiiiiiiiieineneenenecneenenns xiii
ASG Customer SUPPOrt . ..o vvt vttt iiieineeeensoessssssssssessensonnss xiii
Intelligent Support Portal (ISP). . ... ... . Xiv
Telephone SUPPOTt . .. ..ottt e Xiv
ASG Documentation/Product Enhancements .................ooiiiiiiienn. xvi
1 Introduction. ....eeeeeeeeeeeeeoossooosossssoosssssssssssssscsssssssssss 1
ASG Service Pack . ... v ittt i i i i i i ettt i 1
Encore OVverview. .. ..coeitiiiiiiiiiiiiiieneeneneeneneenesncsecnsnacnns 2
Encore Components . ... ........iuintit et 2
Operating Environment . . ........c.itiuiitiitieieenerernocersnrossnsessns 5
Environment . .. ... 5
COBOL Compilers . . ..ot e e et e e e et e e 5
Preprocessor SUPPOTt . .. ..o 6
2 CuStomizZatiOn .....cvietteiereeenseseoseseosssessessnsssensosansasnns 7
PrerequiSite . .......coititiiiiiiiiiiiiieineenrnosersocessnrsccnsascnss 7
Step 1 - Modifying CNTL Library Members...........ciiiiiiiinrinnrnnenns 8
Step 2 - Adding Encore Modules to MLPA/PLPA ...........ccciiiiiininnne. 10



ASG-Encore Installation Guide

Step 3 - Customizing Panvalet or Librarian............ ... .oooiiiiiiiiaa.. 11
Panvalet Customization. . .. ........ vttt 11
Librarian Customization . . ... ..... 'ttt ettt ettt 12
Step 4 - Customizing the Module Header Box .. ..............coiiiiiiats. 13
Step S - Setting up the Encore/COBOL/SF Interface ...................00.e. 13
Step 6-Invoking Encore. . .......coitiiiiiiiiiiiiinrneenteecnrnosnsnnns 14
To invoke Encore froman ISPFpanel ............ ... ... ... ... ..o on... 14
To invoke Encore using a CLIST . ... ... . it 14
Step 7 - Validating Encore .........coiiuiiitiiiiiiiiiiriinnrsenrsnssnnnes 14
GlOSSAIY « i ivitinenresnssesnasassssassssssssssssssssnsssosscsansasnas 53
Appendix A
Encore CNTL and CLIST MemDbers « ..o eeeeeeecccooooooossoosossoooooonsnsssss 67
Encore CNTL Members. . ..ccvieiniiiiiiiiieiieeneenenecnenecnsnncnenns 67
Encore CLIST Members ......ouiutitiiiiiiieiieneenenecnenocnenncnenns 68
IndexX. . oo viriii ittt iieiieiteeteateeseessescenssossoascanssnssnses 69

ii



Preface

This ASG-Encore Installation Guide explains the installation and maintenance of
ASG-Encore (herein called Encore). Encore is a powerful interactive system that helps
analysts and programmers to re-engineer, redevelop, or maintain existing COBOL
systems.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:

. Chapter 1, "Introduction," contains an overview of product installation,
re-engineering analysis, code extraction analysis, target generation, and operating
environments.

. Chapter 2, "Customization," describes the customization of specific Encore
components, invoking Encore, and validating the Encore installation.

il
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Related Publications

v

The documentation library for ASG-Encore consists of these publications (where nn
represents the product version number):

Note:

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by
most ASG-Existing Systems Workbench mainframe products. ASG-Center must be
installed before installing ASG-Encore.

ASG-Encore Installation Guide (ENX0300-nn) explains the installation and
maintenance of ASG-Encore.

ASG-Encore Reference Guide (ENX0400-nn) provides detailed information about
the pop-ups, screens, and commands used in ASG-Encore.

ASG-Encore User’s Guide (ENX0200-nn) provides user information about
ASG-Encore.

ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality
for this release.

To obtain a specific version of a publication, contact ASG Customer Support.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figure 1 + ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Center ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis

. . ASG-SmartDoc for Program Documentation
Analytical Engine |«

A4

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

Application
Knowledge
Repository (AKR) - TS0
- CICs

- IMS

- ASM

- APS

- PLI

- TCA for Test Coverage Analysis
- DB2 Stored Procedure

ASG-SmartTest for Testing/Debugging
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vi

This table contains the name and description of each ESW component:

ESW Product

ASG-Alliance

Herein Called

Alliance

Description

The application understanding component that is
used by IT professionals to conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance allows the programmer/
analyst to accurately perform application analysis
tasks in a fraction of the time it would take to
perform these tasks without an automated
analysis tool. The impact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

The bridging product that enables field expansion
for program source code, without being required
to simultaneously expand the fields in files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for all ESW products.
Center provides the common Analytical Engine to
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergistically.




Preface

ESW Product Herein Called  Description

ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
The code generation facilities allow you to use the
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enables the user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify data flow,
find program anomalies, and trace logic paths. It
also has automated procedures to assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysis information can also be viewed
interactively or exported to a database,
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
source listing, structure charts, program summary
reports, exception reports for program anomalies,
and software metrics.

vii
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ESW Product Herein Called  Description

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the ISPF/PDF
Editor is invoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supports all versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest ~ SmartQuest The diagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programs in the TSO,
MVS Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembled object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site starts a
product directly, use the ISPF selection or CLIST as indicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the ISPF selection or CLIST as indicated by your systems administrator and then
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration" on page ix for more information about
using ESW.

viii
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To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Product Name (ESW Name) Shortcut  ESW Pull-down Options
Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure P ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure » Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly, or through the main ESW screen. As a result, different fields, values,
action bar options, and pull-down options display on a screen or pop-up depending on
how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic
link to Alliance that can be used to display program analysis information. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data relationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed.

X
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Access to these integrated products requires only that they be installed and executed in
the same libraries.

Example 1

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure 2 « Encore Primary Screen

File Uiew Edtract Generate 3Zearch List Options  Help

RAEG-EnCore
CoHAHand ===
etttk debebbk kbbbt Aottt
ettt Hbtebk bbbkl Atk
Atk Htebk Bass s S o s 2 Aotk
Atttk Atttk Atttk etk =tk
Attt
Atttk

Copwright Allen systeds Group, Inc., an unpublished wark.
A proprietary product of A%G, Inc.  Use restricted to authorized licensees.
Uizit the ASG Zupport Web Zite at www.asg.cod
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Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer P Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3« ESW Encore Primary Screen

File Wjew Extract Generate $£earch Logic List Options Help

AFE-EZN - Prograd Re—engineering

ComAand ===
ettt Hbtebk bbbkl Atk
Aottt Akt bbbk Aotk
Atttk Atttk Aotttk etk Atk
etk etttk Aotttk etk Aok
Atk
etttk

copwright ALlen SysteWs Group, INcC., an unpublished vork.
A proprietary product of A%G, IncC. Use restricted to authorized licensesaz.
Visit The ASE Support Web %ite at wuw,asg.coM

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xii shows the File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figure 4 « File - Analyze Submit Screen

File - Analyze ZubMit
CorAdand ===

E - Edit TCL 2 - Eubnit TCL

CoHpile and link JCL [PDE o sequentiall:
Data =&t nade

Analyze features [v-M]:
AEG-EMartTests ¥ Extended Analysiss N

AKR data set nawe
AER prograd nane  NEWDEHO [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [Y<H] « v o« v o o o o i) [7¥ if needad bY features)
Link load Hodule reusable® [Y-M] Y
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The actions shown on these screens can also vary. For example, the D - Doc Options
action is only available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc is installed on your system. In Figure 4 on page xi, the
ASG-SmartDoc Options action is not displayed.

Figure 5« ASG-ESW - Prepare Program Screen (accessed through ESW)

CoHHand ===

A%E-EZW - Prepare PrOgrand

E - Edit JCL F - EubRit TJCL

CoHpile and link JCL [PDE o sequentiall:
Data set name

0 - Doc Options

Analyze features [v-N]:

Understand: W Testl Y Extended Analysizs N DocuHent: M
Re-engineer: W Abend<Dunpl N

AER data et nane

AKR prograd nade  NEMDEHO [if overriding PROGRAR-ID0]

Analyze options:

CoHpile? [¥N]
Link 1oad Hodule reusable® [Y-M] T

[v if needed by features)
[Test and Abend-ODuHp onlyl

Notice that the Analyze features field in Figure 5 lists additional ESW products than
shown on Figure 4 on page xi. This field is automatically customized to contain the ESW
products you have installed on your system. These are the names of the analyze types:

ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test

Extended Analysis (ASG-SmartTest with Extended Analysis

Insight installed)

Xii
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ASG uses these conventions in technical publications:

Convention

Represents

ALL CAPITALS

Initial Capitals on Each Word

lowercase italic
monospace

Monospace

Vertical Separator Bar (| )
with underline

Underline

ASG Customer Support

Directory, path, file, dataset, member, database,
program, command, and parameter names.

Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plus sign
(+) is inserted for key combinations (e.g., Alt+Tab).

Information that you provide according to your
particular situation. For example, you would replace
filename with the actual name of the file.

Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Options available with the default value underlined (e.g.,
YIN).

Denotes a cursor-selectable field or line.

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG products is the responsibility
of the respective vendor. In the event a vendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of

that unsupported version.

xiii
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (ISP). Your logon information for ISP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where:

NNNNNNNNNN is your customer ID supplied by ASG Product Distribution.
XXXXXXXXXX is your unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide provides instructions on how to use the
ISP and is located on the ASG Support web page.

Telephone Support

Xiv

To expedite response time, please have this information ready:

Product name, version number, and release number

List of any fixes currently applied

Any alphanumeric error codes or messages written precisely as displayed
A description of the specific steps that immediately preceded the problem

Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in a text file on the distribution media
included with the Service Pack. You can access the latest software corrections and Service
Packs via the ISP.

The severity code (ASG Customer Support uses an escalated severity system to prioritize
service to our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes

2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has ~ Within 4 hours

work-around solution

"How-to" questions and enhancement Within 4 hours
requests


http://www.asg.com/support/support.asp
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The Americas

Phone Fax E-mail

800.354.3578 1.703.464.4901

United States and
Canada

support@asg.com

Europe, Middle East, and Africa (EMEA)

During normal business hours, we recommend that you call the Central Support number
first (except in South Africa).

Phone Fax E-mail

Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl@asg.com
Spanish 34.913.523.800 34917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com

Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com

All Other Countries (Also for any non-working numbers)

Phone

Fax

E-mail

All other countries

1.239.435.2201

support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.

XV
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ASG Documentation/Product Enhancements

Xvi

Submit all product and documentation suggestions to ASG’s product management team
at http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp

Introduction

This chapter describes Encore product installation, re-engineering analysis, code
extraction analysis, target generation, and operating environments, and contains these

sections:
Section Page
ASG Service Pack 1
Encore Overview 2
Operating Environment 5
Note:

Center installation and customization must be performed before installing Encore. If
Center has not been installed, see the ASG-Center Installation Guide at this time.

ASG Service Pack

Verify whether you received an ASG Service Pack for this product. If so, read the
instructions for installing the Service Pack before proceeding with the product
installation. The installation instructions are located in the text file on the distribution
media included with the Service Pack. If you have any problems with the Service Pack,
contact ASG Customer Support.
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Encore Overview

Encore is the ESW re-engineering product for COBOL applications and includes these
features:

. Analysis facilities that allow you to extract code based on the most frequently used
re-engineering criteria.

. Code generation facilities that allow you to use the results of the analysis extract to
generate a standalone program, a callable module, and a complement module. Prior

to code generation, you can view and modify the extracted logic segment using the
COBOL editor.

Encore is designed to support these functions:
. Web enablement

. Open interface

. Platform and technology migration

. Re-implementation of business functions
. Component-based maintenance

Encore contains a Common User Access (CUA) interface with action bars, pull-down
menus, and pop-up screens that make it easy to learn and use.

Encore Components

Encore is comprised of these four functional components:
. Re-engineering analysis

. Code extraction

. Migration

. Target generation



1 Introduction

Re-engineering Analysis Overview

Encore’s re-engineering analysis displays the source code in various levels. The
re-engineering analysis component consists of these three displays:

View Methods Contents of Views

Structure Displays the hierarchical relationships within the program in a
graphical mode. You can zoom in on the actual COBOL source
represented by the graphical display.

Tree Displays the program in logical execution order. This view allows
straightforward analysis of how the program works.

Source Displays the program in source code order and offers
COBOL-intelligent browsing capabilities.

The main purpose of re-engineering analysis is to gather enough information about the
program to make the best decision regarding code isolation and extraction.
Re-engineering analysis is available through the View facility.

Extract Overview

Encore’s main focus is the Extract facility, which addresses the re-engineering aspects of
code renewal, and provides the capability to isolate and extract logical code segments
from existing programs. These are the eight methods you can use to isolate and extract
code:

Objective Type  Purpose

Perform Range  Isolates and extracts a specific named PERFORMed range of code
within the COBOL program.

Transaction Isolates and extracts all code required for a specific transaction (i.e.,
all code between a start point and multiple end points that is, or
could be, executed based on the values of a data variable).

Computation Isolates and extracts all code that calculates a specific data variable

Variable from the beginning of the program to a specific statement in the
program.

Report Isolates and extracts all code necessary to produce a set of identified

output (WRITE) statements.

Statement Isolates and extracts a user-selected set of COBOL source
statements.
Complement Extracts the original program, excluding statements from a

previous extract.
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Objective Type  Purpose

Common Code Identifies code common to two or more previous extracts.

CICS Server Isolates and extracts all code required to generate a CICS server

program.

See the ASG-Encore User’s Guide for more details about the Extract facility.

Migration

The most basic feature of Encore is to convert an existing MVS COBOL application to a
component-based architecture. Encore provides these capabilities for migration:

Clear separation of user interface and data access code from the business logic.

Removal of redundant logic.

Target Generation Overview

Target Generation addresses the disposition of the segment created in the Code
Extraction phase. For Target Generation, Encore provides these capabilities:

Separate program generation.
Callable module generation.

Complement module generation consisting of the original program with the
extracted Logic Segment removed.

10 module generation containing all input/output functions for an FD (File
Description).

Logical COBOL segment access with an editor, such as ISPF Edit or SmartEdit for
modification and customization.

Knowledge retention that helps with everyday maintenance tasks or major system
rewrites.

Logic Segment extraction used for input to CASE tools.

The Target Generation environment is a powerful lever against change. When business
needs call for enhancements to a specific function, only one Logic Segment is impacted,
dramatically reducing the time required for analysis and change.
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Operating Environment

This section describes the platforms on which Encore runs and the hardware and software
requirements for running the application.

Environment

Encore products have these requirements:

Platform Software

. MVS/XA, MVS/ESA, or OS/390

Host
. MVS ISPF Version 3.5 thru 4.8 (3.1 is the minimum
supported release level, Estimate requires ISPF 3.3
(minimum supported release level))
. BATCH region size of 4096 KB or larger
. TSO logon region size of 2048 KB or larger below 16 MB
. Direct Access storage
. 3270 type terminals; Models 2, 3, 4, or 5
. VSAM (required if any AKR is allocated as VSAM)
Clients Windows 95/98/2000 or Windows NT with access to MVS
Servers 0S/390

COBOL Compilers

ESW

Note:

products support these COBOL compilers:
COBOL D, E, and F

COBOL I

COBOL/370

COBOL for MVS and VM

COBOL for 0S/390 and VM

Object oriented extensions added to COBOL for MVS and VM, and to COBOL for
0S/390 and VM are not supported.
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Preprocessor Support
Encore supports these preprocessor languages directly:
. Command-level CICS
. Command-level DL/I
. IDMS
. SQL

Note:
Other preprocessed languages are not recognized, but can be supported from the
generated COBOL code.




Customization

This chapter describes customizing specific Encore components, invoking Encore, and
validating Encore installation, and contains these sections:

Prerequisite 7

Step 1 - Modifying CNTL Library Members 8

Step 2 - Adding Encore Modules to MLPA/PLPA 10
Step 3 - Customizing Panvalet or Librarian 11
Step 4 - Customizing the Module Header Box 13
Step 5 - Setting up the Encore/COBOL/SF Interface 13
Step 6 - Invoking Encore 14
Step 7 - Validating Encore 14

Prerequisite

Center installation and customization must be performed before customizing Encore.

Note:

If Center has not been installed, see the ASG-Center Installation Guide before attempting
to install or customize Encore.
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Step 1 - Modifying CNTL Library Members

Use these CNTL library members to compile and analyze Encore demonstration
programs. Modify these members to specify a valid JOB card and correct parameter
values, but do not execute them at this time:

Member Description

VIAACMPI1

JCL to compile the ASG VIARDEMO demonstration program.

VIAACMP2

JCL to compile the ASG VIARDRIV and VIARSUBR
demonstration programs.

VIAACMP3

JCL to compile the ASG VIARANOM demonstration program.

VIAACMP4

JCL to compile the ASG VIARBRWS demonstration program.

Note:

Each CNTL member requires the use of a COBOL II Release 3 or newer compiler.

Specify the correct values for these parameters:

Parameter Description

VIASOFT

Specify the high-level node where the ESW products are installed.

CENTER

Specify the second-level node where ESW products are installed. If
the ESW dataset names contain more than three nodes, then specify
all nodes except the first and the last as CENTER. For example, the
dataset name SYS3.CENxx.NEW.LOADLIB should have
VIASOFT=SYS3 and CENTER=CENxx.NEW.

SYSOUT

Specify the correct SYSOUT character.

SYSDA

Specify the appropriate UNIT for temporary datasets.

COMPILR

Specify the COBOL compiler load module name. It currently
defaults to the COBOL II compiler.

COBCOMP

Specify the COBOL compiler load library name. It currently
defaults to the COBOL II library name.
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Specify the correct values for these VIAACMP3 and VIAACMP4 CNTL library member
parameters:

Parameter Description

CICS Specify the high-level node(s) where the CICS Command
Translator/Preprocessor was installed.

CICSCOB Specify the low-level node where the CICS Command
Translator/Preprocessor copybooks have been installed.

CICSLIB Specify the low-level node where the CICS Command
Translator/Preprocessor load library was installed.

CICSTRAN Specify the CICS Command Translator/Preprocessor load module
name.

TRNPARM Specify the CICS Command Translator/Preprocessor parameters
that are required by your facility.

To override the default Encore installation options, follow this step:

Note:
Perform this action only to override Encore default installation options.

» Edit the ASG.VIACEN xx.CNTL member VIASPRMA and modify these options:

COBOLSF=NO ; Default=NO
Gen-COBOL-Last-Node=COBOL ; Default=COBOL
NETRON=NO ; Default=NO

See the Installation Option appendix in the 4ASG-Center Installation Guide for
information about changing the installation option values.
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Step 2 - Adding Encore Modules to MLPA/PLPA

These are the Encore load modules that can be added to the Modified Link Pack Area
(MLPA) or Pageable Link Pack Area (PLPA), which are re-entrant and linked
AMODE(31), RMODE(ANY).

VIAENC

VIARISPP

VIAZBTCH

VIAZTBLP

VIARCMMP

VIARICSF

VIAZCMDP

VIARCSHI

VIARCSOM

VIAZGENP

VIARCSFM

VIARWKSP

VIAZPRIP

For the names of all the modules that are eligible for location in the MLPA or PLPA, see
the installation guide for the other ESW products you have installed.

These are some advantages to locating modulesin the MLPA or PLPA:
< A reduction of the memory requirement per user
= Anoveral decrease in required swap space

- Performance improvements

10
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Moving these modules to MLPA/PLPA is optional. ASG recommends that you keep the
original ESW load library (from the installation tape) as a staging library so you can
apply any required PTFs. You can copy the re-entrant modules to LPA and the
non-re-entrant modules to a separate user library. These steps also require changes to the
user's logon or product allocations. The CNTL library contains two members, VIASLPAJ
and VIASLPXJ, which can be used to perform these steps.

Note:

Do not use the ISPF 3.3 copy feature to copy these modules because some of them have
aliases.

Step 3 - Customizing Panvalet or Librarian

Panvalet Customization

To customize Panvalet

Note:

Do not perform step 1 if you are using Panvalet R12 and the module PAM is available in
LINKLST or LPA.

1 Edit CNTL member VIASPAMI and specify a valid JOB card and the correct values
for these parameters:

ASMBLR

PANLIB

SYSOUT

SYSDA

VIASOFT

CENTER

2 Submit this job to assemble and link edit the Panvalet VIASPAM module.
If Panvalet requires changes to its customized edit panel, these changes may need to be

included in the ESW panel VSPEDPAN. If this situation occurs, contact ASG Customer
Support for instructions.

11
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If the Panvalet load library is allocated under ISPLLIB and the LIBDEF facility is used,
WTP MEMBER NOT FOUND warning messages display each time you select a Panvalet
member. Try these alternatives to correct the problem:

. Adding Encore allocations to LOGON and bypassing LIBDEF processing.
. Adding the Panvalet load library allocation to VIALLIB in LIBDEF processing.
. Setting WTPMSG OFF (not recommended).

Librarian Customization

12

To customize Librarian

1 Edit CNTL member VIASFAIJ and specify a valid JOB card and the correct values

for these parameters:

ASMBLR

LIBRLIB

LIBRMAC

SYSOUT

SYSDA

VIASOFT

CENTER

If you are running on Librarian R3.9, edit CNTL member VIASFAIR and comment
out the four lines containing these delete statements:

DELETE
DELETE
DELETE
DELETE

2 Submit this job to assemble and link edit the Librarian VIASFAIR module.

If Librarian requires changes to its customized edit panel, these changes may need to be
included in the ESW panel VSPEDLIB. If this situation occurs, contact ASG Customer

EPLOC=XFAIROPN
EPLOC=XFAIRMOD
EPLOC=XFAIRREC
EPLOC=XFAIRCLS

Support for instructions.
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If the Librarian load library is allocated under ISPLLIB and the LIBDEF facility is not
used, WTP MEMBER NOT FOUND warning messages display when you select a
Librarian member. Try these alternatives to correct the problem:

Adding Encore allocations to LOGON and bypassing LIBDEF processing.
Adding the Librarian load library allocation to VIALLIB in LIBDEF processing.
Setting WTPMSG OFF (not recommended).

Step 4 - Customizing the Module Header Box

When a module is generated, a header box is placed at the beginning of the source code.
You can modify the template for the header box to conform to site standards.

To modify the header box template, follow this step:

» Edit CNTL member VIARCBSK. All text in the member can be edited except for the

symbolic parameters (i.e., parameters that begin with &).

Step 5 - Setting up the Encore/COBOL/SF Interface

To interface between Encore and COBOL/SF

1

2

Edit CNTL member VIASPRMA and add COBOLSF=YES.
Edit CNTL member VIARCSFP. This member specifies the dataset name
allocations to be performed when COBOL/SF is invoked during the ANALYZE

process.

a  Verify, and change if necessary, the high-level node for the COBOL/SF
libraries. The default is ECF.V2R2M1.

b  Specify a VOLSER for the SSQTEXT VSAM dataset. The default is question
marks.

Edit CLIST member VIAACSF. Verify, and change if necessary, the high-level node
for the COBOL/SF libraries. The default is ECF.V2R2M1.

Ensure that ECF.V2R2M1.SECFEXCO is included in SYSPROC allocation. This is
described in the Host Installation section of the Program Directory for COBOL/SF.

13
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Step 6 - Invoking Encore

To invoke Encore from an ISPF panel

Use these panel definition cards to add an Encore option to the ISPF primary menu or
another dialog menu.

. This entry describes the Encore option to the user:

[o)

% EN +ASG Encore - COBOL re-engineering Environment

. This entry invokes Encore when the letters EN are entered:

EN, ’CMD(%ENCORE) NEWAPPL (VIAR)'

Note:

After updating the ISPF environment you may need to re-enter ISPF before the facilities
become available.

To invoke Encore using a CLIST

Use either of these methods to invoke Encore using a CLIST:

. Type TSO VIAENC on the command line in the ESW Primary screen. The
VIAENC CLIST invokes the ENCORE CLIST while specifying the
NEWAPPL(VIAR) parameter to set the correct application ID.

. Type EN on the command line in the ESW Primary screen. The EN CLIST
automatically invokes a pre-defined ENCORE CLIST.

Step 7 - Validating Encore

14

Note:

The dataset names used in the following validation steps are the default installation
names. If you have changed them, use the changed names in place of the default names.

To verify logon library allocations

1 Enter Encore by selecting the correct option from the appropriate menu.

Note:

If you installed Encore as indicated in "Step 6 - Invoking Encore" on page 14 use
the appropriate selection on the ISPF menu or the CLIST.
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Select Help » About and press Enter to display the Help - About pop-up, as shown

in Figure 6.

Figure 6 « Help - About Pop-up

Help - About

The following is release information for this A3G

product.

Product nawe . . . . . . . ! ASG-Encore
Release number . . . . . @ X.X
Maintenance level . . . . @ XXX

A3G-CENTER release number : X.X
Maintenance level . . . . @ XXX

Operating system . . . . . @ O3(390)

This pop-up displays the product release and level of Encore that is installed. It also
contains the product name, product release number, product maintenance level, and

the operation system.

Press PF3/15 to exit the Help - About pop-up.

Select Options P Product Parameters and press Enter to display the Options - Product

Parameters pop-up, as shown in Figure 7.

Figure 7 « Options - Product Parameters Pop-up

Options - Product Parameters

Type desired product parameters. Then press

Enter.

Cursor Substitution Character

COBOL Module Exit

Options Default View

Alarm 4
Confirm on Exit

Save EQUATES

Save EDIT File

1.

2.
3.
4.

Structure Vieuw
Tree VYieuw
Source Yiew
None

Review and/or modify the parameter definitions and press PF3/15 to exit

15
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5  Select Options » Product Allocations and press Enter to display the
Options - Product Allocations pop-up, as shown in Figure 8.

Figure 8 « Options - Product Allocations Pop-up

Options - Product Allocations
Command ===> _
Log file:
Generic unit . . . SYSDA [generic group name or unit address)
Volume serial . . [blank for authorized default volume)
List file:
Generic unit . . . SYSDA [generic group name or unit address)
Yolume serial . . [(blank for authorized default volume)
Punch file:
Generic unit . . . SYSDA (generic group name or unit address)
Volume serial . . [blank for authorized default volume)
Work file:
Generic unit . . . SYSDA (generic group name or unit address)
Volume serial . . [blank for authorized default volume)
Space units . . . CYLS (BLKS, TRKS or CYLS)
Primary space . . 5 [space units)
Secondary space 5 [space units)

Review and/or modify the allocations and press PF3/15 to exit.

6  Select Options » Log/list/punch to display the Options - Log/List/Punch Definition
pop-up, as shown in Figure 9.

Figure 9 « Options - Log/List/Punch Definition Pop-up

Options - Log/List/Punch Definition
Command ===>

1 - Process log file 2 - Process list file 3 - Process punch file
4 - Customized data set name

Options Log List Punch
Process option . . . . . . PD PK K
Primary tracks R 1 1
Secondary tracks L. 2 5 5
Lines per page . . . . . . 5B 56 56
Sysout class . . . . . . . % X *

Process options: PK (print/keep), PD (print/delete), K, or D.

Job statement information:
//NAME JOB [(ACCOUNT), ' (NAME) ',

/7 MSGCLASS=A
/7% INSERT '/xROUTE PRINT NODE.USER' HERE IF NEEDED.
/7%

a  Review and/or modify the log, list, and punch file defaults.

b  Enter the Job statement information and press PF3/15 to exit

16
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7 Select Options » PF keys and press Enter to display the Options - PF Key Definition
pop-up, as shown in Figure 10.
Figure 10 » Options - PF Key Definition Pop-up
Options - PF Key (01-12) Definition
Command ===> _
Press Enter to process changes and/or to display alternate keys.
Press PF3/15 (END) to exit.
Number of PF keys: 24 Terminal type: 3278
PFO1 HELP
PFO2 SPLIT
PFO3 END
PFO4 Z0OMIN
PFO5 RFIND
PFOB FX %
PFG7 UP
PF08 DOWN
PFO9 SWAP
PF10 LEFT
PF11 RIGHT
PF12 RECALL
a Review and/or modify the PF key definitions (press Enter to switch between
PF keys 1-12 and 13-24).
b  Press PF3/15 to exit
To allocate an AKR
1 Select File » AKR Utility and press Enter to display the File - AKR Utility pop-up,
as shown in Figure 11.
Note:
If you have already created an AKR when validating another ESW product, proceed
to the section "To analyze the demonstration program" on page 19 .
Figure 11 * File - AKR Utility Pop-up
File - AKR Utility Program: VYIARBRWS
Command ===> _
Blank - Display member list D - Delete member
A - Allocate/expand AKR R - Rename member
Application Knowledge Repository (AKR):
Data set name . "USER.TEST.AKR'
Member [if "R" or "D" selected)
New name (if "R" selected)
Volume serial . [if not cataloged]
Password (if password protected)
2 Enter the name of an AKR to be allocated.

17
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3  Type A on the command line and press Enter to display the File - AKR
Allocation/Expand pop-up (see Figure 12).

Figure 12 « File - AKR Allocate/Expand Pop-up for a VSAM AKR without SMS

File - AKR Allocate/Expand

Command ===>
S - Submit JCL E - Edit JCL C - Specify Catalog
Expand existing AKR . . . NO (Yes or Nol
AKR data set name . . . . "USER.TEST.AKR’
Volume . . . . . . . .
Unit . . . . . . . .. (Generic unit name)
Space units . . . . . . RECORDS (Records, Tracks or Cylinders)
Primary space . . . . . 4000 (Primary amount in above units)
Secondary space . . . . O (Secondary amount in above units)

Job statement information:

//USER JOB (ACCOUNT) , NAME,

/7 MSGCLASS=A

/1% INSERT ’"/xROUTE PRINT NODE.USER' HERE IF NEEDED.
/1%

Note:

The fields on the File - AKR Allocate/Expand pop-up may vary depending on the
settings for the Center installation parameters, AKR-DSORG-VSAM and SMS. See
the ASG-Center Installation Guide for more information.

4  Verify that the name is correct and enter the appropriate values for the Management
Class, Storage Class, and Data Class fields if you are using SMS managed datasets.

If you did not specify SMS managed datasets in the CENTER installation parameter
SMS while installing Center, the fields pertaining to SMS are not displayed. In that
case, enter these values as required:

a For VOLUME, type the value where the permanent AKR is to be placed.

b  Review the Space units and Space amount values.

¢ Type the appropriate UNIQUE parameter for the volume selected if you are
allocating a VSAM AKR.

d  If this dataset needs to be cataloged under a user catalog, type C on the
command line to display the AKR Catalog Information pop-up. Enter the
Catalog DSN and password as required, and press PF3/15 to exit.

e  Type the JOB statement information for your site and type S on the command
line to submit the job.
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f After the job finishes, verify that the AKR was successfully allocated and

initialized.
g  Press PF3/15 until you return to the Encore Primary screen.

To analyze the demonstration program

1 Select File » Analyze and press Enter to display the File - Analyze
as shown in Figure 13.

Figure 13 » File - Analyze Submit Pop-up

Submit pop-up,

Command ===>

File - Analyze Submit Program: YIARANCM

E - Edit JCL S - Submit JCL

Compile and link JCL (PDS or sequential):
Data set name 'USER.TEST.CNTL (MEMBER)'

Analyze features [Y/N):
ASG-Encore: Y

AKR data set name "USER.TEST.AKR'
AKR program name (if overriding PROGRAM-ID)

Analyze options:

Compile? [¥/N) . . . . . . . .. N (¥ if needed by features)
Link load module reusable? (Y/N) N (ASG-SmartTest/ASG-SmartQues

t only)

a  Type the AKR dataset name from step 2 on page 17.

b  Setthe Compile flag to N.

¢ Type S on the command line to submit the job.

2 Verify that the analyze job completed successfully. If the analyze j

ob did not

completed successfully, see the ASG-Center Installation Guide for additional

information.
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These are the compile and link JCL dataset names required for the Compile and link JCL
field on the File - Analyze Submit pop-up shown in Figure 13 on page 19:

Dataset/Member Description

ASG.VIACENxx.CNTL(VIAACMP1) For program VIARDEMO.

ASG.VIACENxx.CNTL(VIAACMP2) For programs VIARDRIV and VIARSUBR.

ASG.VIACENxx.CNTL(VIAACMP3) For program VIARANOM (¥*). You can use
the Analyze options field shown in Figure 13
on page 19 to enter analysis report
parameters or to use the batch-driven
Anomaly Repair Facility.

ASG.VIACENxx.CNTL(VIAACMP4) For programs VIARBRWS.

Note:
Each CNTL member requires the use of a COBOL II Release 3 or newer compiler.

(*) For VIARANOM, you can use the Analyze options field on the File - Analyze Submit
pop-up to enter these analysis report parameters. These parameters are used to produce
analysis reports that help you understand and diagnose analysis problems and anomalies:

»  VIARERPT - stops the analysis process after the analysis report is generated.

VIARERPTAN - continues the analysis process after report generation and saves
the information in the AKR.

. NUMPRMA(##) - specifies the number of parameters allowed before a CALL is
listed in the Excessive Parameter List report.

. RPTCEN - centers the generated report (default is left justified).
You can also use these analyze parameters in the Analyze options field to use the

batch-driven Anomaly Repair Facility to correct certain anomalies that may exist within
your code:

*  VIAANOMEF - runs the Anomaly Repair Facility in batch mode. You can also use
the online method by entering these additional operands on the Anomaly
Facility - Batch Submit screen:

— PARM(user parm) - any valid user parameter (e.g., DEBUG).

— ANOMALY - required, used to specify these types of anomaly fixes:
— OOPGT - for out of perform GOTO
—  GTD - for GOTO depending

— IPR - for inconsistent performance ranges
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— COMMENT(YES or NO) - includes/omits original commented out code in new
repaired code. YES is the default.

— DSN - name of the output dataset for the repaired code. If you do not specify a
dataset name, output defaults to DD VIAANOUT. If DSN is a sequential file,
do not code the MEM parameter.

—  MEM - member name of the output dataset if you specified a DSN. Do not code
if DSN is a sequential file.

— HEADER(YES or NO) - includes/omits an ASG header at the beginning of
repaired code. YES if the default.

Example:

VIAANOMF, PARM (DEBUG1) , ANOMALY (OOPGT, GTF, IPR) , COMMENT (YES) ,
DSN (" ASG.ANOMALY .REPAIRED.CODE’ ) ,MEM (MEM1) , HEADER (YES)

See the online help, the ASG-Encore User’s Guide, and the ASG-Encore Reference
Guide for more information about these parameters.

To validate the Analyze Submit CLIST
1 Enter one of these commands from the ISPF Primary Menu:

TSO VIASUBDS 'ASG.VIACENxx.CNTL (VIAACMP1)'
Or

TSO VIASUBDS 'ASG.VIACENxx.CNTL (VIAACMP2)'

2 Repeat step a through step 2 from "To analyze the demonstration program" on page
19.

To verify Structure View
1 Select File » Open and press Enter to display the File - Open Program pop-up.
2 Enter the AKR dataset name and the program name VIARDEMO.

a  If applicable, enter the appropriate dataset password.

b  Press Enter to open the program and display the Encore Primary screen.
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3 Select View P Structure and press Enter to display the View - Structure View
Request pop-up, as shown in Figure 14.

Figure 14 » View - Structure View Request Pop-up

View - Structure Yiew Request
Type request options. Then press Enter. For a name selection list
for a range (other than 1 or 2), type a pattern [e.g. ABCx) in the

name field.

Levels 2  of 5 of depth

Range
1 1. Procedure division
2. All entry points
3. Perform range name
4. Entry point name
5. Nested program name
Name
Options

Repetition

4  Enter these values in the appropriate fields:
. Levels: 3 (maximum)

. Range: 1 (procedure division)
The Name field and Repetition option should be left blank.

5  Press Enter to display the Structure View screen showing the message ASG15821
3 OF 3 LEVELS DISPLAYED IN THE VIEW.

6 Select Search » Data and press Enter to display the Search - Data Name pop-up, as
shown in Figure 15.

Figure 15 » Search - Data Name Pop-up

Search - Data Name

Type & data name and select search options. Then press Enter. For
a selection list, enter a pattern (e.g. ABC*) in the name area.

Data nemwe WE-INTEREST

References Indirect impact Size change

1 1. A4ll 1 1. MNone levels . . . 1
2 Defs 2. ©Of size change
3. Uses 3. ©Of walue change
4 Hods

Direction Options Aotion

1 1. &ll _ Ho data aliasing 1 1. Find

IN-clause. .. 2. Highlight

3. Exclude

22
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a  Enter this information:
—  Data Name: WK-INTEREST
—  References: 1
— Indirect impact: 1 (If Insight is installed)
— Size change levels: 1 (If Insight is installed)
—  Direction: 1
—  Options: Blank

— Action: 1
b  Leave the Options and (if present) Size change levels fields blank.

Press Enter to redisplay the Structure View screen. On the Structure View screen, the
message ASG0443I 3 DATA REFS: 1 DEF, 1 USE, 1 MOD, FOUND
FOR WK-INTEREST should display. The box labeled UPDATE-ACCT THRU
UPDATE®* should be highlighted.

Note:

If Insight is installed complete step 1 through step 5 on page 24. If Insight is not
installed, proceed to step 1 on page 24.

Steps to complete if Insight is installed

1

Select Logic P Data and press Enter to display the Logic Order Search - Data Name
pop-up and enter this information:

. Data Name: WK-INTEREST
. Start line/label: PROCEDURE
. References: 1

. Direction: 1

. Options: Blank

. Action: 1

Press Enter. The short message, 1 REF (S) REACHABLE displays. The box labeled
UPDATE-ACCT THRU UPDATE* should be highlighted.
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3  Select View » Zoom In.
Or
Type ZOOMIN on the command line.

Move the cursor to the highlighted box (UPDATE-ACCT THRU UPDATE®*).

4  Press Enter to display the View - Source pop-up, as shown in Figure 16. This pop-up
displays with the code for the selected unit highlighted and the rest of the program
excluded.

Figure 16 * View Source Pop-up

View Search Logic List ©Options Help

View - Source SCREEN POSITICHNED
Command ===> Seroll ===»> CSR
000273 UPDATE-ALCCT. FERF ENG
--= - - - - - - - - - - - - - - = 1 LIMNE MNOT DISFLAYED
aoozvs FPERFORM INIT-ACTICHN-RECORD. FERF ENG
--= - - - - - - - - - - - - - - = 1 LIMNE MNOT DISFLAYED
aoozT? IF ACCT-TYPE OF ACCT-RECORD = 'INT' FERF ENG
aoozvs MCWVE CHE-INTEREST-RATE TO INTEREST-RATE FERF ENG
aoozve ELSE IF ACCT-TYPE OF ACCT-RECORD = 'CHE' FERF ENG
aoozeo MCWVE ZERO TO INTEREST-EATE FERF ENG
ooozEl ELSE IF ACCT-TYPE OF ACCT-RECORD = 'MMA' FERF ENG
ooozsz MCWVE MMA-INTEREST-RATE TO INTEREST-RATE FERF ENG
000z53 ELSE IF ACCT-TYPE OF ACCT-RECORD = '3AW! FERF ENG
000zE4 MCWVE SAV-INTEREST-RATE TO INTEREST-EATE. FERF ENG
--= - - - - - - - - - - - - - - = 1 LIMNE MNOT DISFLAYED
O00zZE6 IF ACCT-MULTI-ACCT = 'YE3' FERF ENG
Qooza? ADD CHE-MULTI-ACCT-RATE T2 INTEREST-RATE FERF ENG
O00zZEs MCVE ACTICHN-MULTI-ACCT TO WORK-ALCTICHN-EEASCH FERF ENG
ooozes PERFORM INITIATE-ACTICHN. FERF ENG

5  Press PF3 twice to return to the Encore Primary screen.

Steps to complete if Insight is not installed:

1 Select View » Tree to display the View - Tree View Request pop-up and enter this
information:

. Levels: 4 (maximum)
. Contents: 1

. Range: 1

Leave the Name and Repetition option fields blank.
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Press Enter to display the Tree View screen (Figure 17). The message ASG15821

4 OF 4 LEVELS DISPLAYED IN THE VIEW displays.

Figure 17 » Tree View Screen

File Wiew Extract Gernerate Search List Options Help

Tree View LINE 1 OF 21
Command === Scroll ===: CSR

TOP OF DATA
gaao@a  PROCERURE DIVISION USIMG COMTROL-PARAMETERS, ERAMCH-BALAMCE,
QEEEEZ IMITIALIZE-PGM.
[elala]e]ax] OPEN-FILES.
[ela el ] GET-MHUM-0F -DAYS.
[elaalelaky SUM-TOTAL -DATS.
QEaEaz ACCT-MATHTEMAMCE.
[elal el k] ACCT-MAINTENAMCE-EXIT.
[elaalela ] IMITIATE-ACTION.
[elaa]e]a ] ACCT -MAIMTENAMCE-EXIT. REFEATED
[elala]e]ax] UPDATE-ACCT.
oaa004 IMIT-ACTION-RECORD.
[elaa ety IMITIATE-ACTION. FEPEATED
aaa0ng IMITIATE-ACTION. REPEATED
aaacang IMITIATE-ACTION. REFPEATED
[elaelelaty FEPEATED
[elaa]e]a ] | ASGISEZI 4 OF 4 LEVELS DISPLATED IN THE VIEW. |
ARAEE3
QaanEz ACCT-MATMTENMAMCE-EXIT.

Type LEVELS 3 on the command line and press Enter. The message ASG15821
3 OF 4 LEVELS DISPLAYED IN THE VIEW displays as the number of levels

displayed is reduced to 3, as shown in Figure 18.

Figure 18 « Tree View Screen with Levels Displayed Message

File Wiew Extract Gernerate Search List Options Help

Tree View LIMNE 1 OF 15

Command === Scroll ===: CSR
TOP OF DATA

0aa00a  PROCERURE DIVISION USIMG COMTROL-PARAMETERS, BRAMCH-BALAMCE,

QEEEEZ IMITIALIZE-PGM.

[elaa]e]a ] OPEN-FILES.

AEAEE3 + GET-HUM-0F -DAYS.

QaaEE2 ACCT -MATMTEMAMCE.

QEEGEEE ACCT -MAIMTENAMCE-EXIT.

[elaa]e]a ] IMITIATE-ACTION.

[elal el k] ACCT -MAIHNTENAMCE-EXIT. REFEATED

QEEDEE + UPDATE-ACCT.

[elaa]e]a ] UPDATE-ACCT-EXIT.

[elala]e]ax] EXCEPTION-REPORT-1.

QaaEa2 ACCT-MATMTEMAMCE-EXIT.

QEEEEZ REPORT -FIMAL-CHTRS.

QEaEaz CLOSE-PGM.

[elalc]e]ax]

debtotobek opeetek | ASG13821 3 OF 4 LEVELS DISPLAYEDR IM THE YIEMW. B
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4  Type JUMP on the command line, as shown in Figure 19, position the cursor on any
of the source lines, and press Enter.

Figure 19 » Tree View Screen

File W“iew Extract Generate Search List Options Help
Tree Yiew LIME 1 OF 15
Command === JUMP Scroll ===: CER
TOP OF DRTA
QooZoa  PROCEDURE CLIVISIOWM USIMG COMTROL-PARAMETERS, BRAMCH-BALAMCE,
QEoDaz IMITIALIZE-PGM.
[elaldlald] OPEM-FILES.
QEODEE + GET-MUM-0F -DATS.
je]alalalae ACCT-MAINTEMAMCE.
[elalalaldi] ACCT-MAIMTENAHCE-ERIT.
QEEEEE IMITIATE-ACTION.
QRODEE ACCT-MAIMTEMANCE-EXIT. REFEATELD
QEODEE + UFDATE-ACCT.
[elalolaldi] UFDATE-ACCT-EXIT.
[lalalalax] EXCEPTIOM-REFORT-1.
[elalolaldye ACCT-MAINTEMANCE-EXIT.
QEoDaz REFPORT-FIHAL-CHTRS.
[elatalaldy CLOSE-PGM.
[elalalale]
s | ASG1SE2I 2 OF 4 LEVELS DISFLAYED IM THE WIEW. | LR SR Ea i a sy

The View - Source pop-up displays with the cursor positioned on the selected line,
as shown in Figure 20.

Figure 20  View - Source Pop-up Showing JUMP Results

Wiew Search List Options Help
View - Source Program: “YIARDEMO

Command === Scroll === CiSR
ooe243  JCCT-MAIMTEMAMCE.
CIDE244
Qoa245 REACD TRAM-FILE
QOA24E AT EHD
Qo247 MOYE EOF-LITERAL TO TRAM-FILE-FLAG
QoEz24s GO TO ACCT-MAIMTEMAMCE-EXIT.
Qoez49
QEAZ30 ADD +1 TO TRAM-CHT.
QoEzs1
Qoezsz2 MOYE TRAM-ACCT-KEYT TO ACCT-KET.
[o]ala e
ooaz254 READ ACCT-FILE  EEY IS ACCT-KEY
LEE2SS IMVALID KEY
QEAZSE MOYE ACTIOM-MISSIMG-ACCT TO WORKE-ACTIOM-REASON
QEAZST MOYE SPACES TO ACCT-RECORD
Qoazss PERFORM IMITIATE-ACTION
QEEzs9 MOYE +4 TO WORK-RETURM-CODE

5  Press PF3 twice to return to the Encore Primary screen.
To verify Perform Range extract processing

1 Select Extract P Perform Range and press Enter to display the Extract - Name Logic
Segment pop-up.

2 Accept the default name or type PERFORM-RANGE-0001 in the Name field, and
press Enter to display the Extract - Perform Name List pop-up.
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3 Press PF5 (Filter) to display the Extract - Perform Range Filter pop-up, as shown in
Figure 21.

Figure 21 » Extract - Perform Range Filter Pop-up

Extract - Perform Range Filter
Type information for filtering PERFORM Range Name list.

PERFORM Name

Data Name

Use Context Options

1 1. FReferences /  Aliasing
Z. Uses
3. Modifications

Line Range .
COBOL 3ubset COUTFUT
Text Pattern

4  Inthe COBOL Subset field, type the subset name OUTPUT and press Enter to
redisplay the Extract - Perform Name List pop-up, which shows the PERFORM
Ranges associated with the COBOL subset OUTPUT (see Figure 22).

Figure 22 » Extract - Perform Name List Pop-up

Extract - Perform Namwe List
Command ===> Seroll ===»> CSR

Select PERFOREM Range name (s) for extract. Then press Enter. Press
Enter when cowmplete. Use Z30RT comand to order column by value.

3 - Zelect V - View Source T - Unselect
Size Times PERF Direct Subord
PERFOREM Range Name Lines % PERF by FPERF= FPERF=
- < —-———— ———= == - >
_ ACCT-MAINTENANCE THRU ACCT-MAI 27 12.86 1 1 3 4
_ EXCEPTICHN-REPORT-1 16 7.62 1 1 a a
5 INITIATE-ACTICH 13 6.19 5 Z a a
_ BREPORT-FINAL-CHNTR3I 5 Z.38 1 1 a a
UPDATE-ACCT THRU UPDATE-ACCT-E 52 Z4.76 1 1 Z Z

FEEREELRAEALRAARRLRARARAXRATRLAT BOTTOM OF DATL FrA S oA na s aa A n S w A A ARG RARAL LT

PF4=View PF5=Filter PF17=3ort

5  Type S on the INITIATE-ACTION line and press Enter to highlight the line.

6  Press Enter again to return to the Encore Primary screen.
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To highlight the logic segment lines and exclude non-segment lines

1 Select View P Logic Segment and press Enter to display the View - Select Logic
Segment pop-up, as shown in Figure 23.

Figure 23 » View - Select Logic Segment Pop-up

View - Select Logic Segment 1 LOGIC SEGMEMTS
Command === _ Scroll ===r C35R
S - Select
Program Logic Segment Mame Description
S VIGRDEMO PERFORM-RANGE-0BO1 Perform Range

EOTTOM OF DATA

2 Select PERFORM-RANGE-0001 and press Enter. The Source View screen displays
with the logic segment lines highlighted and the non-segment lines excluded, as
shown in Figure 24.

Figure 24 » Source View Screen

File Wiew Extract Gernerate Search List Options Help
Source View Program: WIARDEMO

Command === Scroll ===: CSR

e T S I B 19 LIMES HOT DISFLAYED
oEE243  ACCT-MAINTEMAMCE. LOGICSEG
--=- - - - = - - = - - - - - - - - - - 1LIME HOT CISFLAVED
QEEz245 READ TRAM-FILE LOGICSEG
QEE246 AT EHD LOGICSEG
Qa0z247 MOYE EOF-LITERAL TO TRAM-FILE-FLAG LOGICSEG
Q242 GO TO ACCT-MAIMTEMAMCE-EXIT. LOGICSEG
--=- - - - - - - = = - - - - - - - - - 1 LIME HOT DISFLATED
QEEZ5A ADD +1 TO TRAM-CHT. LOGICSEG
- - - - - - - - - - - - - - - - - - - - 1 LIME HOT CISFLAVED
QEE232 MOWE TRAM-ACCT-KET TO ACCT-KEY. LOGICSEG
--=- - - - - - - - - = - - - - = - - - 1 LIHE HOT DISFLAYED
oEa254 READ ACCT-FILE KEY I5 ACCT-KEY LOGICSEG
GIEE25S IMWALID KEYT LOGICSEG
QEE2 56 MOYE ACTIOM-MISSIMG-ACCT TO WORK-ACTION-REASOH LOGICSEG
QEE2ST MOYE SPACES TO ACCT-RECORD LOGICSEG
QE0252 FERFORM IMITIATE-ACTION LOGICSEG
QEE239 MOYE +4 TO WORK-RETURM-CODE LOGICSEG
QEEZEE GO TO ACCT-MAIMTEMAMCE-EXIT. LOGICSEG

3 Press PF3 to return to the Encore Primary screen.
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To save the Logic Segment

1

2 Customization

Select File » Save Segment and press Enter to display the File - Save Logic Segments

pop-up.

Select PERFORM-RANGE-0001 and press Enter to display the File - Save Segment

pop-up, as shown in Figure 25.

Figure 25 « File - Save Segment Pop-up

File - 3ave Seguent

Type segment definition information. Then press Enter.

Chjective . . . . :!: Perform Range

huthor . . . . . . : UIERID

Created . . . . . ! DD-MMM-YYYY HH:MM:33
Name . . . PERFORM-RANGE-OO0O01

Description PERFORM-RANGE-EXTRACT

Comrand === Zeroll === C3R

Long Description:
TEST SEGHMENT FOR INSTALLATICHN.

Enter this information:
. Name: PERFORM-RANGE-0001
. Description: PERFORM-RANGE EXTRACT

. Long Description: TEST SEGMENT FOR INSTALLATION

Press Enter to display the short message SAVE SUCCESSFUL.

Press PF3 to return to the Encore Primary screen.
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To verify Logic Segment generation processing

1 Select Generate » COBOL Module and press Enter to display the Generate - Select
Logic Segment pop-up, as shown in Figure 26.

Figure 26 * Generate - Select Logic Segment Pop-up

Generate - Select Logic Segment 1 LOGIC SEGMEMTS
Command === _ Scroll ===r C35R
S - Select
Program Logic Segment Mame Description
S VIGRDEMO PERFORM-RANGE-0BO1 Perform Range

EOTTOM OF DATA

2 Select PERFORM-RANGE-0001 and press Enter to display the Generate - COBOL
Module pop-up (see Figure 27). VIARDEMYV displays in the Program ID field.
Leave the Options field blank.

Figure 27 « Generate - COBOL Module Pop-up

File Wiew Extract Gernerate Search List Options Help

Generate - COBOL Module Program: WIARDEMO
c
Tupe Frogram ID and select generation options.
stttk kb ok

Objective . . & Perform Range sttt bk ok
Program I . . YIARDEMY
Options ekt
_ ECALLs to I0 Medulels) sheokeskokskokek

ek

skt

ASG42121 DEFAULT PROGRAM ID YALUE ASSIGHEDR. YERIFY, AND CHAMGE IF
HECESSARY.

Copyright Allen Systems Group, Inc., an unpublished work,
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Visit the ASGE Support Web Site at www.asg.com
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6

2 Customization

Press Enter to display the Generate - Specify Perform Range ENTRY Names
pop-up, as shown in Figure 28.

Figure 28 » Generate - Specify Perform Range ENTRY Names Pop-up

Generate - Specify Perform Range EHTRY Hames
Cammand ===3> — Scroll ===» C5R

Specify the ProgramID and ENTAY names af the modules to be generated.
S - S5plit H - Howve I - Inte + - Espand - - Cellapse

Program EHTRY PERFORH Range Mame

ERLEHERIEENEE XM LFWERXRRERRNE TOP OF DOTA #3WOHLHMF0 3000 ER LRXFRIEN SR L
Y IARDEMY *INITIATE-ACTION

Fraexeerexewseewxexxwrexemex st BOTTOM OF DATH *t%rtatmet xesert e is et et

Press Enter again to display the Generate - Multi-module PERFORM Ranges pop-up
(see Figure 29).

Figure 29 » Generate - Multi-module PERFORM Ranges Pop-up

Generate - Multi-module PERFOAHM Ranges
Command === Zcrell ===» CzA

Select the module to generate, then press Enter.

Frogram ID  ENTRY Hame FEAFIRM Range Mame

AEXAMELXAMEL XA WNXA XA XM XA Ex X JOF OF DATH CXamxd xxmxd Xaw i XXX XKL KW

S YIARDEMY INITIATE-ACTION
EHHERER RN R ERE RN R 0wk BOTTOH OF DIRTE S stin S0 0 000 200 E% 08N

Select VIARDEMYV and press Enter to display the Edit screen. A COBOL
subprogram corresponding to the logic segment is generated. The Edit screen
appears displaying the subprogram. The message ASG1608I ENTER THE
CREATE COMMAND TO SAVE THE COBOL PROGRAM also displays.

Press PF3 four times to return to the Encore Primary screen.
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To verify program Edit processing

pop-up, as shown in Figure 30.

Select File » Edit Program and press Enter to display the File - Edit Options Request

Figure 30  File - Edit Options Request Pop-up

File View Extract Generate Search Li
File - Edit Options Request
If desired, select the Edit Options
screen display. Then press Enter.
Options
/ Display options screen
KKK K R K KK
KKK KK KK XK *
KK KKK KKK KK R K KK KKK K K KK R K K K
KKK K K OKOK R K KKK KR KR KO K K KK KK R
Copyright Allen Systems Group, Inc.
A proprietary product of ASG, Inc. Use re
Y¥isit the ASG Support Web Site at

st Options Help

Program: VYIARBRWS

KKK KKK KKK KKK KK KKK KKK KKK KK KKK K
KKK K KKK KKK KKK K KKK DK KKK KK KK KK K
KK KKK
XK KKK
3K KK XK

3K KK XK 3K K 3K K K K

KEEKKK  KEKKK KKK K KK KK

HAKKEK K KKKK KKK

KEKKEK  KKKEK X KK

HCROKOK KK K 3K K K 3K K K 3K K K 3K K 3K K K K

£33 2K K 2K K K 2K K K 2K K K KK KK K

, an unpublished work.
stricted to authorized licensees.
WWW.asg.com

Options pop-up (see Figure 31).

Figure 31 » Edit Options Pop-up

Type any non-blank character in the Options field and press Enter to display the Edit

File View Extract Generate Search Li
File - Edit Options Request
I Edit Options s
s
Source Manager
1 1. PDS/Sequential
2. Librarian
3. Panvalet
T-- 4, scekw ] mmmmee-
5. Other (User)
x
————————————————————————————— KKK X KK
KK K K SIS KOK K OK KKK K KKK KK K OK KK K K K

Copyright Allen Systems Group, Inc.
A proprietary product of ASG, Inc. Use re
V¥isit the ASG Support Web Site at

st Options Help

Program: VIARBRWS

KKK KKK KKK KKK KKK KKK K KK KK KKK K
KKK KKK KKK KK KK KKK K KK K KK K K K K K
KK KK K
KK KKK
KKK K

KK KKK KK K K KKK

KKK KKK KKK KKK KK

KAKKEK  KAKKKK KKK

HAKKK KK KKK KKK

HORKOK 0K K K K K KK K K K K XK K X K K

£33 KK K 3K K K 3K K KK K K K K KK K

, an unpublished work.
stricted to authorized licensees.
WWW . asg. com
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2 Customization

3  Ensure that the Source Manager is PDS and press Enter to display the Edit Entry
Panel (see Figure 32).

Figure 32 » Edit Entry Panel

Meny RefLizt AezfMode Urilities LMF Horkstatisn Help

Edit Entry Panel
Cammand ===%

ISPF Library:

Froject . . . ASG

Greup . . . . YIRCEMxz= .

Type . . . . CNTL

Member . . . YIARDEMO [Blank or pattern for member selection list)

Other Partitioned or Sequential Data Set:
Data Set Name
Volume Saerial . . . [If not cataloged]

Workstation File
File Mame .

Dptians
Initial Macro . . . . /' Confirm Cancel/Hove/Replace
Frofile Name . . . . . Mised Mode
Farmat Mame . _ . . . Edit on Morkstation
Data Eet Passward . . Freserve YEB record lemgth

. Type the dataset name of the Encore product installed CNTL library in the
PROJECT, GROUP, and TYPE fields.

. Type VIARDEMO in the MEMBER field.
. Press Enter to display the Editor screen (see Figure 33).

Figure 33 » Editor Screen

ASG-Encore EDIT - WIARNEA.FROD.CHTLLWIARDEMO) - BO.0G COLUMMHS B0081 0aa72
Command ===: DISPLATY Scroll ===: CSR
Top of Cata
aaa10a ao21aa IDEMTIFICATION DIVISION.

QRAZ00 AE0ZA8 PROGRAM-ID. “YIARDEMO.

QEO30E QEE3EE AUTHOR. ASG DEMOMSTRATION.

QEa400 AR040E

QEAS03 AR5

QEOEEE AEEEDE:: THIS PROGRAM DOES THE MOMTH EMD CALCULATIOMS FOR EACH TYPE #
CEETER EEE TR OF CHECKIMG ACCOUMT CARRIED EV THE UMIMERSAL EAMK. IT *
CQRESE0 R0 EE:: HEMDLES THE FOLLOWIMG TYPES OF ACCOUMTS. *
CEESEE EEESEE:: CHECKIMG WITH IMTEREST *
QO1000 00100 CHECKIMG WITH HO IMTEREST *
QE1100 BEL LA MOMEY MARKET ACCOUMT CHMA) *
QE1200 Q1 20E SAVINGS ACCOUNT *
AE1360 G601 306 IT ALSD UPDATES THE ACCOUNT BALAMCE, BRAMCH BALAMCE AMD *
001400 001400 BAME BALAMCE. *

QE15E0 aals
QR1EED o1EDE
Aa17EE aei7aa ENVYIRONMENT DIVISION.

el

Qa1 | ASGLER2I EMTER THE DISPLAYT COMMAMD FOR LOGIC SEGHMEMT IMFORMATION. |
[z

ooziod o2igo IMPUT-O0UTPUT SECTION.

4  Type DISPLAY on the command line and press Enter. The lines of the current logic
segment display and the non-segment lines are excluded.
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5 Type FX WK-INTEREST on the command line, as shown in Figure 34, and press
Enter.

Figure 34 « Editor Screen - FX WK-INTEREST Command

ASG-Encore EDIT - WIARMED.PROD.CHTL(WIARDEMO) - E@.03 COLUMHS @ooa1 aaa72

Command ===r FX WE-IHMTEREST Scroll ===: CSR
Top of Cata

- - - - - - - - - - - - - - - - - - - 37 Line(s) not Displayed

HI===: [OQ33@a 21 ACCT-RECORD.

- - - - - - - - - - - - - - - - - - - 1 Linels) not Displayed

HI===: GQ4a0a 05 ACCT-KEY.

- - - - - - - - - - - - - - - - - - - | Linel(s) not Displayed

HI===: OQo4208a 18 ACCT-TYPE PIC H(2).

- - - = = = = - - - - - - - - - - - - 72 linels) not Displayed

HI===: QG450 @5 ACCT-MIM-BALAMCE FIC S9lE)wag,

HI===: QG400 @5 ACCT-AWG-BALAMCE FIC S9(6)wa9.

HI===: Qo470 05 ACCT-MULTI-ACCT PIC Hi3).

- - - = = = = - - - - - - - - - - - - 1 Linels) not Displayed

HI===: QG430 @5  ACCT-IMTEREST FIC SalE)wag,

- - - - - -15 Lineis) not Displayed

HI===: QOQOS&OQ 01 TRAM-RECORLD.

- - - = = = = = - - - - - - - - - - - 1 Lineis) not Displayed
HI===: QQoS20a @5 TRAM-ACCT-KEY.

- - - - - - - - - - - - - - - - - - - 25 linels) not Displayed
HI===: [QQg4 E " .

HI===: QG35 ASG16A4I ALL LOGIC SEGMEMT LIMES WERE DISPLATED.

- - - - - not Displayed
HI===: Q@OS700 77 CHK-IMTEREST-RATE PIC 5904)4304) COMP-3

If SmartEdit is not installed, the message COMMAND FX NOT FOUND displays, as
shown in Figure 35.

Figure 35 » Editor Screen - FX Command Not Found Message

COMMAND FX NOT FOUND

If SmartEdit is installed, the message ASG0639I 3 DATA REFS, 1 DEF, 1
USE, 1 MOD found for WK-INTEREST diSplayS.

6  Ifnecessary, erase the FX command and return to the Encore Primary screen by
pressing PF3/15 four times.
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To validate IDMS support by analyzing an IDMS program

1 Select File » Analyze and press Enter to display the File - Analyze Submit pop-up,
as shown in Figure 36.

Figure 36 » File - Analyze Submit Pop-up

File - Analyze 3ubmit Program: WILRDEMO
Command ===

E - Edit JCL 3 - Submit JCL

Compile and link JCL (FPD3 or seguential):
Data set name 'UIER.TEST.CNTL (MEMEER)'

inalyze features ([V/N):
AZ3G-Encore: ¥

ALER data set name 'UIER.TEIT.AKR'
ALKE program hame [if owverriding PROGRAM-ID)

Analyze optiohs:

Compile? (¥/N) . . . . . .« . . . o) [T if needed by features)
Link load wodule reusable? (¥/M) N [L3G-SmartTest only

a Enter the dataset name for the compile and link JCL for the IDMS program to
be analyzed.

b  Enter the AKR dataset name.
¢ Set the Encore analyze flag to Y.
2 Type S on the command line and press Enter to submit the analyze job.

3 Verify the analyze job ran successfully by checking for a return code of 0 or 4.

Note:
Return codes higher than 0 (zero) usually indicate a compiler message.
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36

To validate DB2 support by analyzing a DB2 program

Note:
If you have DB?2 installed, verify that ASG.VIACENxx.CNTL(VIASBIND) ran
(see the ASG-Center Installation Guide for more information). This installation step
is required for sites using DB2. Failure to complete the DB2 installation step results
in erroneous behavior by ESW products.

Select File » Analyze to display the File - Analyze Submit pop-up.

a Enter the dataset name for the compile and link JCL for the DB2 program to
be analyzed.

b  Enter the AKR dataset name.

c Set the Encore analyze flagto Y.

Type S in the command input area and press Enter to submit the analyze job.
Verify the analyze job ran successfully by checking for a return code of 0 or 4.

Note:
Return codes higher than 0 (zero) usually indicate a compiler message.

Select File » Close and press Enter to close the VIARDEMO program. Save any
logic segments, if desired.

To verify parameter-driven anomaly repair processing

Note:

Complete these steps if you entered any parameter-driven anomaly repair parameters in
the Analyze options field on the File - Analyze Submit pop-up (see Figure 13 on page
19). This section verifies the VIARANOM anomaly repair parameter processing
discussed in "To analyze the demonstration program" on page 19.

1

Select File » Analyze and press Enter to display the File - Analyze Submit pop-up.

Type VIARERPT in the Analyze options field and submit the VIARANOM analyze
job.

When the job finishes review the DD VIARERPT output, which shows the
anomalies that were found. Because of the VIARERPT option used in this example,
the analyze job will not finish and will not add VIARANOM to the AKR.



2 Customization
Review the output from DD VIARERPT, noting that VIARANOM contains three
anomalies that can be repaired.

a Perform a second analysis using the these parameters in the Analyze options
field:

VIAANOMF, ANOMALY (00PGT, GTD, IPR)
b  Submit the job and verify that it completes with no errors.
¢ Review the DD VIAANOUT output to verify that it contains the repaired code.

d  Verify that an ASG header generated at the top of the generated code and that
the repaired code is commented out and new code was added.

Use the generated repaired anomaly code to perform a normal Encore analyze with
no anomaly options or parameters and verify that it analyzed correctly.

Perform the VIARANOM analyze again, but this time use the DSN parameter to
send the output results to an allocated PDS and member.

a  Setthe COMMENT and HEADER parameters to NO.

b  Submit the job and verify that the repaired code was written to the specified
PDS and member.

¢ Verify that the output does not have an ASG header added to it and that the
original fixed code is no longer commented out.

Perform the VIARANOM analyze one more time, sending the anomaly output to an
allocated sequential file.

Submit the analyze job and verify that the repaired code was written to the sequential
file.
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To verify online panel-driven anomaly repair processing

Note:

Complete these steps if you entered any online panel-driven anomaly repair parameters in
the Analyze options field on the File - Analyze Submit pop-up (see Figure 13 on page
19). This section verifies the VIARANOM anomaly repair processing discussed in "To
analyze the demonstration program" on page 19.

38

Select File » Analyze and press Enter to display the File - Analyze Submit pop-up.

Type VIARERPTAN in the Analyze options field and submit the VIARANOM
analyze job. When the job finishes review DD VIARERPT, which shows the
anomalies that were found. The analyze job finishes and adds VIARANOM to the
AKR.

Select File » Anomaly facility and press Enter to display the File - Anomaly Facility
selection screen.

Select Batch Anomaly Repair and press Enter to display the Anomaly Facility -
Batch Submit pop-up.

a Enter the AKR dataset name and AKR program name fields (VIARANOM for
the program name).

b  Select the type of anomalies to repair from the Anomalies to be repaired
section.

¢ Verify that the job information is correct and submit the job.

d  When the job finishes, verify that there are no errors and review DD
VIAANOUT to verify that it contains the repaired code.

e  Verify that an ASG header generated at the top of the generated code and that
the repaired code is commented out and new code was added.

Using the generated repaired anomaly code, perform a normal Encore analyze with
no anomaly options or parameters and verify that it analyzed correctly.



2 Customization

6  Perform the VIARANOM analyze again, but this time use the Output dataset name
and Output member name fields to send the output results to an allocated PDS and
member.

a Press PF4 and deselect the Comment out changed lines? and Generate ASG
header? fields.

b  Submit the job and verify that the repaired code was written to the specified
PDS and member, the output does not contain an ASG header, and the fixed

code is no longer commented out.

7  Perform the VIARANOM analyze one more time, sending the anomaly output to an
allocated sequential file by filling in the Output dataset name field.

8 Submit the analyze job and verify that the repaired code was written to the specified
sequential file.

To verify anomaly report processing, follow this step:

Note:

Complete this section if you entered any anomaly report generation parameters in the
Analyze options field on the File - Analyze Submit pop-up. This section verifies the
VIARANOM anomaly report generation parameter processing discussed in "To analyze
the demonstration program" on page 19.

P Validate the anomaly report(s) using the JES Master output generated from the
program analyze.

The VIARERPTAN parameter generates analysis anomaly reports. Sample generated
reports are shown in Figure 37 and Figure 38 on page 40. See the ASG-Encore User'’s
Guide and ASG-Encore Reference Guide for more information about generating the
anomaly reports.

Figure 37 « Dead Data (In Copy) Report

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
DEAD DATA (IN COPY) REPORT

# This report lists the nurber of dead data (unreferenced data names)

# found in each copy menber.

***************************************************************************

NUMEER DEAD NAMES FOUND IN COPY MEMEER

2 USER.HOLD.CNTL (MEMBER)
35 CIC3330.LIBRARY (MEMBER)

DD-MMM-YY¥Y HH:MM:33 PROGRAM: VIARANOM
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40

Figure 38  Excessive Parameter List Report

B e e L]

* EXCESSIVE PARAMETER LIST REPORT *
% *
* This report lists all call statements using an excessive *

* nunber of parameters. The default nuwuber of parameters is 5. *
T AT TR T AR AR TR AT AN AT AT AR AR AR AR TAAMATATNENRARARTERAAATAN

LINE NUMEER CALLS FPROGRLM MUMEER of PARAMETERS
330 'DETRPT!' 9
363 'DETRFT' El
DD-MMM-YY¥Y HH:MM:353 PROGRAM: VIARLNOM

To verify CICS Server extraction

Complete this section to verify that the CICS server extract/generate facilities were
properly installed.

1 Select File P Open to display the File - Open Program pop-up. Specify VIARBRWS
in the Program Name field and press Enter to open the program.

2 Select Extract » Server and press Enter to display the Extract - Name Logic Segment
pop-up, as shown in Figure 39.

Figure 39 » Extract - Name Logic Segment Pop-up

Extract - Name Logic Segment
Type name of logic segment. Then press Enter.

Name . . . CLIENT-SERYER-0001_

The name field on this pop-up contains a default name generated by Encore. You can
assign your own name to the Logic Segment or you can use the default name. For
this example, use the CLIENT-SERVER-0001 default name.

3 Press Enter to display the Server selection pop-up (see Figure 40), which contains a
list of available server types.

Figure 40 » Server Selection Pop-up

File View Extract Generate Search List Options Help

Extract - Server Program: VIARBRWS

Select the type of server to generate.
2K KKK KR KK KK R OK KK K K KK R K OK K K

Tgpe 2K KK KK OR KR K OK K K KK X K K KR XK K K
1 1. CICS KK KKK
2. Self Directed KK KKK
KKK K AR K KKK K
KKK K KKK KK KK
————————————————————————————————————————————— KKK KK KR K
KKK K KKK K HOK KKK K KKK X KK
XXX X KKK KK KK KKK K KK XK R K KK XK K K AR K KK XK KKK KK K K X
KK K K SIS KOK KK KK K K KK KKK K K KK K K K K K KKK KKK KK K K KK KK K K K

Copyright Allen Systems Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
V¥isit the ASG Support Web Site at www.asg.com




2 Customization

Type 1 to select CICS and press Enter to display the CICS Server Endpoints pop-up
(see Figure 41). The CICS Server Endpoints pop-up contains all of the statements
associated with the CICS member. You want to extract all statements that contribute
to the output screen.

Figure 41 « CICS Server Endpoints Pop-up - View Option

Extract - CICS Server Endpelnts

Comimand === Seroll ===% CER
Select the statement for each CICE Server Endpoint and press Enter to wiew
the corresponding Startpoints, This ccreen Will be redicplayed to allowW
additianal Endpolints to be celectad. Press Entar wnen all salections arae
complete.

5 - Select ¥ - ¥iew Source U - Unselect

oAo4s1 EXEC CICS SEND HAP L EROWSE'] MAPSET L WIARBRL']

0a0daz ERASE EMD-EXELC.
W NE0ELE EXEC CICS SEND HAP['BROWSE'] MAPSET ['YIAREAL']

0EnNsLE ERASE EMD-EXEL.

0O0ES?Z EXEG GCIGS SEMD HAP [ BROMWSE 1 MAPSET [ YIARBRL | EMD-EXEG.

0RoE?2 EXEC CICS SEMD HAF['ERAMSE'] MAFSET L' YIARBRL'I|

Oa0ET3 ERASE EMD-EXELC.
_ DedEad EXER £IC% SEMD HAR['BROMWSE'1 MAPSET [ YIAREAL']

0EoeE8a5 ERASE EMD-EXEL,
_ Qo735 EXEC CICS SEMD HAP [ HEMU 1 HAPSET (" YIARMHU') ERASE EWD-EXEC.
EREEHEROEHE RN SR R RN EE Y BOTTOM OF DRTA $R% £ S m el Re REME e s

Note:

If you select the Self Directed server extract type, you can reduce the list of
selectable endpoints by pressing PF5. The Extract - Self Directed Server Filter
pop-up displays, allowing you to specify filtering criteria. See the ASG-Encore
User’s Guide and the online help for more information about the Filter - Self
Directed Server pop-up.

Type V next to the CICS EXEC you want to view. Press Enter to display the View
Source pop-up (see Figure 42).

Figure 42 « CICS Server Extract View - Source Pop-up

View Search Logic List Options Help

View - Source SCREEN POSITICNELD
Command === Goroll ===r CIR
oo0z73 UPDATE-ALCCT. FPERF EHNG
--——- - - - - = - - - - - - = - = - 1 LINE NOT DISPLAYED
oooz7s PERFORM INIT-ACTICN-RECCRD. PERF EHNG
--——- - - - - = - - - - - - = - = - 1 LINE NOT DISPLAYED
oo0z77? IF ACCT-TYPE OF ACCT-RECORD = 'INT' PERF ENG
ooo0z7s NOWE CHE-INTEREST-RATE TO INTEREST-RATE FPEEF EBNG
gooozTs EL3E IF ACCT-TYPE OF ACCT-RECORD = 'CHE' FPEEF EBNG
gooozso MNOWE ZERQ TO INTEREST-RATE FPERF ENG
ooozsl ELZE IF ACCT-TYPE OF ACCT-RECORD = 'HMML' PERF EHNG
goozaz MOWE MMA-TINTEREST-RATE TO INTEREST-RATE PERF EHNG
ooozas EL3E IF ACCT-TYPE OF ACCT-RECORD = '34V! PERF EBNG
000z54 MCVE 2AV-INTEREST-RATE TO INTEREST-RATE. PERF ENG
-—-= - - - - - - - - - - - = - = = 1 LINE NOT DISFLALYED
O00zEe6 IF ACCT-MULTI-ACCT = 'YE3' FPERF ENG
ooozgy ADD CHE-MULTI-ACCT-RATE TO INTEREST-RATE FPERF EHNG
ooo0zss MOVE ACTICN-MULTI-ACCT TO WORK-ACTICON-REASCN PERF EHNG
goozas PERFOEM INITIATE-ACTICHN. PERF EHNG
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Verify that the CICS EXEC server code selected represents the type of code you
want to extract.

Press PF3 to return to the CICS Server Endpoints pop-up (see Figure 43). If
necessary, repeat this process until you find the code you want to extract.

Figure 43 « CICS Server Endpoints Pop-up - Select Option

Extract - CICS Server Endpoints
Command ===% Beroll === CGER

Select the statement for each CICE Server Endpoint and prass Enter to wiew
the correspanding Startpointe, Thic screen will be redicplayed to allow
additional Endpoints to be selected. Press Enter when all selections are

complete.
S - Selact V - Yiew Source U - Unselect
ifclalt: EXEC CICS SEND MAR|'BROWSE') HRPSET ('WIARERM')
0oaaE2 ERASE EMD-EXEC.
s DQEGLE EXEC CICS SEND MAP [ BAOWSE'] HAPSET (" WIARBRW' )
IQO0ELE ERASE EMD-EXEC.
— DooE52 EXEC CICS SEND MAF["BROWSE'1 HAPSET (" VIARERW' ) EMD-EXEC.
0BABT? EXEC CICE SEND MAF|'BROWSE'] HAPSET ['WIARBRY')
0DE6BTA EAASE EMD-EXEC.
_ Dooe34 EXEC CICS SEWD MAP [ ERQWSE'Y HAPSET (" WIARBRW' ]
[ifela] 115 ERASE EMD-EXEC.
0oa7T3s EXEC CICS SEND MAF['MENU'] MAPSETY YIARHMU') ERASE END-EXEC.

FEHSMEELE R RN RE R ER RN 8 BEOTTOM OF DATA MEEMEEEEHEROENERERREE R EMER L4

Type S next to the line you want to select and press Enter to display the CICS Server
Startpoints pop-up (see Figure 44).

Figure 44 « CICS Server Startpoints Pop-up

CICS Server Startpolints
Coammand ===% _ Beroll === CER

Select statements for CICS Server Startpoints and press Enter. Press Enter
When selections are complete to return to the Enﬂpﬂiht‘; Coresan,

Endpaint
5 - Select V - Yiew Source U - Unselect
0ARELE EXEC CICE RECEIVE MAF|'EROWSE') MAPSETL'VIARERM')
OoaGL? RESP [(RESPDNSE] END-EXELC.

FEXENEXEXANE e NER RN e ek wney QOTTOM QOF DATA *XtXERXA X e tNREXamet X tnntit

Type S in the indicated command area.

Or

Press Enter to accept the selection (all highlighted text is preselected).
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2 Customization

Press Enter to return to the CICS Server Endpoints pop-up (see Figure 45). The
message displayed in the long message area confirms that the CICS Statements for
the EXEC CICS SEND code were successfully selected.

Figure 45 « CICS Server Endpoints Pop-up - Selection Confirmation Message

Extract - CICS Serwer Endpoints
Command === Scroll ===r C35R

Select the statement for each CICS Server Endpoint and press Enter to wiew
the corresponding Startpoints. This screen will be redizplayed to allow
additional Endpoints to be selected. Press Enter when all selections are

complete.
5 - Select Yo- Miew Source U - Unselect
— BEE421 EXEC CICS SEMD MAF( EROWSE') MAPSET( WIARERW ')
QRE4E2 ERASE EMD-EXEC.
— BAGE1S EXEC CICS SEMD MAF['BROWSE') MAPSET('WIARERW')
CREELE ERASE EML-EXEC.
— BA0ESZ EXEC CICS SEMD MAFL EROWSE') MAPSETL WIARERW') END-EXEC.
— BEOETZ EXEC CICS SEHD MAF('EROWSE') MaPSETL('WIARERW' )
OREET3 ERASE EMD-EXEC.
— BEDE94 EXEC CICS SEMD MAF( EROWSE') MAPSET( ' WIARERW ')
QREE3S ERASE EMD-EXEC.
— BAAT3S EXEC CICS SEHD MAF('MEMU' ) MAPSETL'WIGRMHLI') ERASE EMD-ERXEC.

| ASGA10ZL CICE STATEMEMTS SUCCESSFULLY SELECTED. |

Press Enter to display the CICS Server Paths pop-up (see Figure 46).

Figure 46  CICS Server Paths Pop-up

Extract - CICE Serwver Paths
Command === - Scroll === CER
Identify conditionsls which are definitely TRUE for the Serwver, those which
are definitely FALSE, and leauve blank the conditionals which may be either
TRUE or FALSE. Press Enter when all selections are complate.

T - TRUE F - FALSE blank - TRUESFALZE W - Yiew Source
T 000285 IF EIBCALEN WNOT = 0 THEM
% 0AO377 IF EIECALEN = 0 THEM GO TO HEXT-LIME.
ooosas IF EIBCHLEN = © THEM GO TO TEST-STRTS.
F DonE3d IF EIBAID = DFHCLEAR THEN
F 0gos40 IF EIBARID = DFHPF1 OR DIRI = "F° THEW GO T0 PAGE-FORHARD.
T 000541 IF EIERID = DFHPFZ OR DIRI = "E° THEM GO TO0 PAGE-EACKWARD.
ERMEHEREERERE R HE R RN R e 2% BOTTOM OF DATA $¥#%#488 $a 8 0 0e £ 249

Default T (TRUE) or F (FALSE) selections have been made based on the selection
criteria. An X indicates that the code does not apply to this extract. You can change
the settings, if desired.

Press Enter to return to the Encore Primary screen, which displays a message
indicating that the criteria for the statement extract was successfully selected.
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To verify CICS server generation

1 Select Generate P Server and press Enter to display the Generate - Select Logic
Segment pop-up, as shown in Figure 47.

Figure 47 « Generate - Select Logic Segment Pop-up

Generate - Zelect Logic Segment 1 LOGIC SEGHMENTE
Command ===} _ Scroll === CSR

3 - Gelect

Frogram Logic Segment Mame Description

5 VYIARERWS  CLIENT-SERVER-0001 Glient Server

ERRFMEFEFREFEFREFXFRAFAFRAFwxFs ¥ BOTTOM OF DATH #xsfmFrusXFREf AT F LR RNEF KR REF LF

Type S next to the Logic Segment name you want to select.
Or

Accept the default selection.

2 Press Enter to display the first Generate - HOST Copy Member pop-ups (see
Figure 48).

Figure 48 « Generate - HOST Copy Member Pop-up Number 1

Gz=nerate - HOST Copy Member 1 0F 2

Enter ned COPY member information. Press Enter when
cnmplete.

Existing Copybocok Infarmaticon
Copy Mamker . . . . . . . :
Data Hawe . . . . . . . . : DFHCOMHARERA

ey Copybock Infarmation
Copy Member . . . . . . CPYCOMAR _
Starting Level Number 5
Level Humber Increment S

Note:

The number of Generate - HOST Copy Member pop-ups displayed during this
procedure depends on the ending and starting statements selected on the
corresponding CICS Server Endpoint (see Figure 43 on page 42) and CICS Server
Startpoint (see Figure 44 on page 42) pop-ups. A minimum of two

Generate - HOST Copy Member pop-ups always display for a generated server.

a Type the new name you want to assign to the DFHCOMMAREA copy
member in the Copy Member field.

b  Assign the Starting Level Number and Level Number Increment you want or
accept the defaults (CICS defaults to a record level of 5).
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2 Customization

Press Enter to display the second Generate - HOST Copy Member pop-up (see
Figure 49).

Figure 49 « Generate - HOST Copy Member Pop-up - Number 2

Generate - HOST Copy Member 2 0OF 2

Enter ned COPY memmer informatien. Press Enter when
CDI‘I‘IPIEIE.

Existing Copybook Infarmation
Copy Memker . . . . . . . i WIRAEBRHC
Data MWame . . . . . . . . : BROWSED

hNeu Copybock Infarmation
Copy Member . . . . v
Starting Level Number 5
Level Humber Increment 5

IRAERC=E

Accept the new copy member defaults.
Or

Change the name and level numbers.

Press Enter to display the Generate - HOST Server Module pop-up (see Figure 50).

Figure 50 « Generate - HOST Server Module Pop-up

Generate - HOST 3erwer Module
Tupe Frogram ID and select generatian aptiens.

Objective . . i Client Serwer
Program ID . . . SERYER

Furctions

L_ 1. Generate options. ..
2, Generate COPY members...
3. Generate server medule
q. Exit
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5  Type 1 to select Generate options and press Enter to display the Options - Generate
pop-up (see Figure 51).

Figure 51 « Options - Generate Pop-up

Dptians - Generate
Select the desired COBOL Module Generate Options.
4 Display EDIT Optiens Output te Existing Library
COEJL Source
Full DATA DIVISION _ PRetain Source Linme Mumbers

Retain COPY statements _ Retain PERFORMed Paragraphs
In-line Communication Area

6  Indicate the options you want for the COBOL Module generation and press Enter.
Press PF3 to return to the Generate - HOST Server Module pop-up.

7 Type 2 to select Generate COPY members and press Enter to display the
Generate - COPY Members pop-up (see Figure 52).

Figure 52  Generate - COPY Members Pop-up

Generate - COPY Wembers
Command === Serell ===» CSR

Select the CORY Members to be generated and press Enter. Press FF3/151END)
when all selections are complete,

§ - Select

COPY Hember Contents Cenerated
% CPYCOMAR DFHCOMHRARER HQ

WIARBRCS BROMSED HO

sxnswaknswaaFensnsRaewx uwmExn X GOTTOM OF DATH FusrassasmEr isma s xs A X AFNANNE
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2 Customization

Type S next to the COPY member you want to select and press Enter to display the
Edit screen (see Figure 53).

Figure 53 « Edit Screen

ASG-Encore EDIT - YIASHG. EMCEOGO3E.COBOL COLUMMHS B0081 0aa72

Command ===: CREATE Scroll ===: CSR
Top of Cata

C 9999 _ @5 RESPOMSE FIC S3(=) COMP.

aaaEaz 05 ASG-DFHCOMM.

[elaalela ] * ASG-EMCORE - DFHCOMMAREA

[elalalelaky *

[elaa]e]a 18 STATS FPIC H01).

QAA0GE i@ RIDE PIC 9(B).

[elaa el 18 RIDF  PIC 3C(E).

[elaa]e]at] 25 ASG-DFHEIBWARS.

[elalclela] 18 ASG-EIBAID  PIC Hi1).

Bottom of Data

| ASGIEOZI ENTER THE CREATE COMMAMD TO SAYE THE COBOL PROGRAM. |

Type CREATE on the command line and C 9999 on the first line of code. Press
Enter to display the Edit/View - Create pop-up to save the module in your source

library (see Figure 54).

Figure 54 » Edit/View - Create Pop-up

Edit/Wiew - Create
Command ===3

"Current” Data Set: USERID.ENCO0033.COBOL

To ISPF Library:

Project . . . ASG
Group . . . . CEGQDXGCC
Type . . . . CHNTL
Member . . . CPFYCOMAR

To Other Partitioned Data 5Set Mewmbher:
Data 3et Name .
Volume Serial . . . [If not cataloged)
Data et Password . . [If password protected)

Enter /" to select option
Specify pack option for "CREATE™ Data 3et

Press ENTER key to create. Enter END command to cancel create.

b

Type the name you want to save the member under in your source library.

Clear any data in the Data Set Name and Volume Serial fields.

10 Press Enter to return to the Edit screen. The Edit screen redisplays with a message in
the upper right corner of the screen confirming that the member was created.
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12

Press PF3 to return to the Generate - Copy Members pop-up (see Figure 55).

Figure 55 » Generate - COPY Members Pop-up

Generate - COPY Members
Command === Scroll === CZR

Select the COPY Members to be generated and press Enter. FPress PF3-1S(EHD)
when all selections are complete,

5 - Select

COPY Member Contents Generat ed
_ CPYCOMAR  DFHCOMMAREA TES
5 WNIARBRCS  BROWSED MO

BOTTOM QF DATA

| ASG43291 COBOL MODULE SUCCESSFULLY GEMERATED. |

A confirmation message displays in the long message area indicating that the
COBOL module generated successfully. The status also changes from NO to YES
under the Generated column. Select the next Copy member and repeat step 8 on
page 47 through step 10 on page 47 to edit and save the member.

Once saved, press Enter and then PF3 to return to the Generate - COPY Member
pop-up.

After the member is saved and you return to the Generate - COPY Members
pop-up, a message displays in the long message area indicating that the COBOL
module generated successfully, as shown in Figure 56. The status also changes
from NO to YES under the Generated column.

Figure 56 « Generate - COPY Members Pop-up

Generate - COPYT Members
Command === Scroll ===r C35R

Select the COPT Members to be generated and press Enter. FPress PF3-1S(END)
when all selections are complete,

S - Select

COPY Member Contents Generat ed
CPTCOMAR  DFHCOMMAREA TES
YIARBRCS  BROWSED TES

EOTTOM OF DATA

ASG4229] COBOL MODULE SUCCESSFULLYT GEMERATED.




2 Customization

13  Press PF3 to return to the Generate - HOST Server Module pop-up (see Figure 57).

Figure 57 « Generate - HOST Server Module Pop-up

Generate - HOST Server Module
ASG43291 COBOL MODULE SUCCESSFULLY GENERATED.

Objective . . : Client Server
Program ID . . . SERVER

Functions

3_ 1. Generate options...
2. Generate COPY members...
3. Generate server module
4., Exit

14 Type 3 to select Generate server module and press Enter to display the Edit screen
(see Figure 58).

Figure 58 « Edit Screen

ASG-Encore EDIT - YIASHG. EMCEOGO44.COBOL COLUMMHS @0081 0aa72
Command ===: CREATE Scroll ===: LCSRE
Top of Cata

C 9993
AaaEEZ
GRS
CEECEG
BARAEEG
[alaele]a i)
QRaCET
CIEEICES
Qa9
[ela/elepRe]
elaioloh i |
[elal o) by
QEaELE
QR0 4
ARaELS
QEOD1E
QEaaLT
[elaila) ]

[elaele) ] ASGIEO2I EMTER THE CREATE COMMAMD TO SAYE THE COBOL PROGRAM.
1o ek

oaaaz1

ASG, IHMC.
GEMERATED BT ASG-EMCORE RELERSE E.010@0E0
FROGRAM: SERVER

LATE: CDr-MEE -7 HH:MM: 55
REQUESTOR: USERID

AKR INFORMATION
LS HAME: USERIL.PART.AKR
MEMEBER: VY IAREBRLWS ALIAS: (MOME)

SEGMEMNT HAME: CLIENT-SERVER-2E01

EEXEEEETEEFTEEXEEE
¥ EEEEEEEEEEEEEEE

OBJECTIVE TVPE: CLIENMT SERVER

a  Type CREATE on the command line.

b  TypeC 9999 on the first line of code.
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15 Press Enter to display the Edit/View - Create pop-up to save the module in your
source library (see Figure 59).

Figure 59 » Edit/View - Create Pop-up

Menu RefList Utilities Help

Edit-Yiew - Create
Command ===

"Current” Data Set: VIASHG.EMCOOG044. COBOL

To ISPF Library:
Project .
Group .

Type
Membet

Ta Other Partitioned Data Set Member:
Data Set Mame . .
VYolume Serial o . . [If not cataloged)

Dats Set Password . . [If password protected)

Enter "-" to select option
Specify pack option for "CREATE" Data Set

Press EMTER key to create. Enter EMD command to cancel create.

a Type the name you want to save the member under in your source library.
b  Clear any data in the Data Set Name and Volume Serial fields.

16  Press Enter to return to the Edit screen (see Figure 60). The Edit screen redisplays
with a message confirming that the member was created.

Figure 60 « Edit Screen

ASG-Encore EDIT - WIASHG. EMCEOG044. COBOL Member SERVER created
Command === Scroll ===: CS
Top of Cata
aaaaa1
aaaEaz * ASG, IMC. *
[elaalela ] * *
[elalalelaky # GEMERATED BY ASG-EMCORE RELEASE E. & E@E]) *
[elaa]e]a * *
QAA0GE #+ PROGRAM: SERVER *
[elaa el * *
[elaa]e]at] #+ DATE: CO=-MEM-T7TYT HH:IMM: S5 *
ABAEE #+ REQUESTOR: USERID *
Qaaoia * *
[elaleleh | + AKR IMFORMATION *
aeaa1z # DS MAME: USERID.PART.AKR *
aaaa13 * MEMBER: Y IARERWS ALIAS: (HOME) *
oaact 4 * *
aaaaLs # SEGMENT MAME: CLIENT-SERVER-2E01 *
aaa01e * *
oaaaL? # OBJECTIVE TYPE: CLIEMT SERVER *
[ela/ale) =] IDEMTIFICATION DIYISION.
aaaa1a FPROGRAM-ID. SERWER.
ABAEZE EMYIRONMENT DIWISION.
oaanz1
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17  Press PF3 to return to the Generate - HOST Server Module pop-up (see Figure 61).

Figure 61  Generate - HOST Server Module Pop-up

Gernerate - HOST Serwer Module

Type Program ID and select gerneration options.

Objective . . @ Client Serwer
Praogram I . . . SERVER
Functians

- 1. Generate options...
2. Generate COPYT members...
3. Generate server module
4. Ewxit

18 Type 4 and press Enter to exit the Generate - HOST Server Module pop-up and
return to the Encore Primary screen.

The customization and verification of Encore is complete.
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Glossary

Abend
Abnormal end of task.

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter.

AKR (Application Knowledge Repository)
A BDAM or VSAM file that contains all analysis information produced by the analyze
function of the Application Analytical Engine.

AKR utility log
File that provides a summary of the commands issued to the Batch AKR Utility.

Alias Of

A field on a pop-up listing entries in the AKR. If the analyzed program contains an Entry
point, Alias Of is the name of the program that contains the Entry point. If the name in the
PROGRAM-ID statement was overridden at the time the analyze job was submitted,
Alias Of is the name that was entered in the AKR program name field on the

File - Analyze Submit pop-up.

analyze
The process by which Encore gathers information about the program, including program
relationships, logic, data and execution paths, and stores this information in the AKR.

analyze options

Runtime options that control the Analyze processing. Many of these options are similar to
the COBOL compiler options. Default values are established at installation time and can
be overridden by editing the Analyzer JCL or by using the analyze screens.

analyze summary report
A summary of the runtime statistics and diagnostic messages that are produced when an

analyze job completes.

anomalies
A deviation or departure from the normal Encore analysis process.
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Anomaly Repair facility

An Encore facility that allows you to repair programs already analyzed in an AKR that
contain anomalies. This is accomplished by allowing you to reanalyze the member that
generated the anomaly condition using the File » Anomaly facility pull-down option.

anomaly reports
Reports that contain information beneficial in understanding and diagnosing analysis
problems and anomalies.

anchor
An HTML element that defines a link between Internet resources.

API
Application programming interface. A set of calling conventions defining how a service
is invoked through a software package.

APPC

Advanced program-to-program communication. An implementation of the SNA LU 6.2
protocol that allows interconnected systems to communicate and share the processing of
programs.

application
Any group of programs that a user wants to analyze/view as a whole. These programs
would all be defined within the same application.

asynchronous
Without regular time relationship, unexpected or unpredictable with respect to the
execution of program instructions. See "synchronous" on page 64.

Batch AKR command
Control cards input in the VIASYSIN DD dataset of the Batch AKR Utility.

Batch AKR utility
The facility used to maintain the AKR without using ISPF.

browser
An application that displays World Wide Web documents.

business group
A logical grouping of applications by business function.

business rule
A logical business function that is performed by a COBOL program.

CERN
The Couseil Europeen pour la Recherche Nucleaire (European Particle Physics
Laboratory), which developed hypertext technologies.
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CICS server extract

A CICS server extract locates the necessary statements, files, and data elements required
to create a CICS Server Extract program. This program is then used to create a
COMMAREA-based server program from a CICS pseudo-conversational program.

client
As in client/server computing, the application that makes requests to the server and,
often, handles the interaction necessary with the user.

client/server computing

A form of distributed processing, in which the task required to be processed is
accomplished by a client portion that requests services and a server portion that fulfills
those requests. The client and server remain transparent to each other in terms of location
and platform. See client above and "server" on page 63 .

COBOL subset
COBOL verbs of a similar nature that have been grouped together. For example, READ,
WRITE, OPEN, and CLOSE are grouped into the IO subset.

command
An option in a menu. A command is selected to perform an action. There are the three
types of commands

. Primary commands
. Line commands

. Batch AKR utility commands

command input area
The field on Encore screens where primary commands are entered, indicated by ===> on
the fourth line of a screen, or the second line of a pop-up.

commit
An action that an application takes to make permanent the changes it has made to CICS
resources.

common code extract

The process of identifying the code that is common to two or more previously-extracted
Logic Segments. This includes all statements that appear in a selected Logic Segment, as
well as appearing in all other selected Logic Segments.

Common Gateway Interface (CGl)
The defined standard for the communications between HTTP servers and external
executable programs.

Common User Access (CUA)
A style of graphical interface that features screens, actions bars, pull-downs, and pop-ups
that are designed to provide easy access to all product features.
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complement extract

The process of identifying a set of COBOL statements that do not include a previous
extract. This includes all statements from the original program, excluding statements of
the previously-extracted Logic Segment, but retaining any statements needed by other
functional paths.

complement module

A complement module contains all statements from the original program, excluding
statements of the extracted Logic Segment, but retaining any statements needed by other
functional paths.

computation variable extract

The process of isolating the minimum set of statements that determine the value of a
particular data variable (known as the computation variable) at a particular statement in
the program.

cursor substitution character
A token substitution character that may be used in some primary commands. The cursor
substitution character is set on the Options - Product Parameters pop-up.

conversational

A communication model where two distributed applications exchange information by
way of a conversation. Typically, one application starts (or allocates) the conversation,
sends some data, and allows the other application to send some data. Both applications
continue in turn until one decides to finish (or deallocate). The conversational model is a
synchronous form of communication.

criteria
The information entered that was used to isolate a Logic Segment.

cursor position
The current location of the cursor on the screen, used as a starting point in certain
commands.

database

. A collection of interrelated data stored together with controlled redundancy
according to a scheme to serve one or more applications.

. All data files stored in the system.

. A set of data stored together and managed by a database management system.

dataname
A standard COBOL term for fields defined in the DATA DIVISION of a COBOL
program. Variable names, files, groups, array elements, and fully qualified datanames.
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data usage
Defines how a data item is used.

. DEF indicates the statements in the DATA DIVISION where the data item is
defined.

. USE indicates the statements where the value is used or tested.
. MOD indicates the statements where the value is set or modified.

. REF indicates any of the above conditions.

dead assignment

A statement that assigns a value to a variable, where the value is not referenced anywhere
in the source code. The assignment is not necessary and may be removed from the code
without affecting program execution.

delimiter
A character or sequence of characters used as a separator in text or data files.

Distributed Computing Environment (DCE)

Adopted by the computer industry as a de facto standard for distributed computing. DCE
allows computers from a variety of vendors to communicate transparently and share
resources such as computing power, files, printers, and other objects in the network.

distributed processing

An application or systems model in which function and data can be distributed across
multiple computing resources connected on a LAN or WAN. See "client/server
computing" on page 55.

Distributed Program Link (DPL)

Enables an application program executing in one CICS system to link (pass control) to a
program in a different CICS system. The linked-to program executes and returns a result
to the linking program. This process is equivalent to remote procedure calls (RPCs). You
can write applications that issue RPCs that can be received by members of the CICS
family.

Distributed Transaction Processing (DTP)

Enables a transaction running in one CICS system to communicate synchronously with
transactions running in other systems. The transactions are designed and coded
specifically to communicate with each other. This method is typically used by banks, for
example in just-in-time stock replacement.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese and Japanese that cannot be
represented with single byte codes.
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environment
The collective hardware and software configuration of a system.

equate
A substitution name for a character string.

External Call Interface (ECI)

An application programming interface (API) that enables a non-CICS client application
to call a CICS program as a subroutine. The client application communicates with the
server CICS program using a data area called COMMAREA.

External Presentation Interface (EPI)

An application programming interface (API) that allows a non-CICS application program
to appear to the CICS system as one or more standard 3270 terminals. The non-CICS
application can start CICS transactions and send and receive standard 3270 data streams
to those transactions.

File Transfer Protocol (FTP)
A protocol that defines how to transfer files from one computer to another.

forms
Parts of HTML documents that allow users to enter data.

function shipping

Enables an application program running in one CICS system to access resources owned
by another CICS system. In the resource-owning system, a transaction is initiated to
perform the necessary operation. For example, to access CICS files or temporary storage,
and to reply to the requester. The user is unaware of these behind-the-scenes activities,
and need not know where the resource actually exists.

gateway
Software that transfers data between normally incompatible applications, or between
networks.

gopher

Menu-based software for exploring Internet resources.

Graphic Interchange Format (GFI)
256-color graphic format.
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help
Encore provides these three levels of help:

. Long messages

. Notes

. Tutorial screens

Specific command information is available by entering a command, then pressing

PFO01/13. The Help facility can also be accessed from the Help pull-down or any Encore
screen.

home page
The default page shown at the first connection to an HTTP server.

host

. In a computer network a computer providing services such as computation,
database access, and network control functions.

. In a multiple computer installation, the primary or controlling computer.

hypertext
Text that activates connection to other documents when selected.

Hypertext Markup Language (HTML)
Standard language used to create hypertext documents.

Hypertext Transmission Protocol (HTTP)
Standard WWW client/server communications protocol.

Internet Keyed Payment Protocol (iKP)
Proposed protocol for conducting secure commercial financial transactions on the
Internet.

intercommunication

Communication between separate systems by means of Systems Network Architecture
(SNA), Transmission Control Protocol/Internet Protocol (TCP/IP), and Network Basic
Input/Output System (NetBIOS) networking facilities.

internet
A collection of networks.

label name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and
PROC literals. Label name specifies all transfers of control to a paragraph or section.

line command
An instruction entered in the line command area on certain screens.

59



ASG-Encore Installation Guide

60

list box
A dialog box option containing a list of items the user can select.

list file
The file that is allocated when a request to print is issued.

live exit
An abnormality in program control caused by out of perform range GO TOs and
overlapping perform ranges.

log file
The file that is allocated by Encore and used for error messages and log commands. There
is a separate log file created by the Batch AKR utility.

logic segment

A set of source statements that is the result of a perform range extract, report extract,
computation variable extract, transaction extract, statement extract, complement extract,
server extract, or common code extract. The criteria used to isolate a Logic Segment may
be saved in the AKR.

logic segment complement
See "complement module" on page 56.

logical program unit
A PERFORMed range of code including GO TO code, or a CALLed program.

Logical Unit of Work (LUW)

An update that durably transforms a resource from one consistent state to another
consistent state. A sequence of processing actions (for example, database changes) that
must be completed before any of the individual actions can be regarded as committed.
When changes are committed (by successful completion of the LUW and recording of the
synch point on the system log), they do not need to be backed out after a subsequent error
within the task or region. The end of an LUW is marked in a transaction by a synch point
that is issued by either the user program or the CICS server, at the end of task. If there are
no user synch points, the entire task is an LUW.

long message

A diagnostic or error message that is displayed on line five of a screen or line three of a
pop-up. Long messages are sometimes preceded by short messages that are displayed in
the upper right corner of the screen. Pressing PFO1/PF13 (HELP) after receiving a short
message displays the corresponding long message.

LU type 6.2 (LU 6.2)

A type of logical unit used for CICS intersystem communication (ISC). LU 6.2
architecture supports CICS host-to-system-level products and CICS host-to-device-level
products. APPC is the protocol boundary of the LU 6.2 architecture.
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markup tag
Special character sequences put in text used to pass information to a tool, such as a
document formatter.

member
A member in a PDS or source manager such as Panvalet or Librarian. This can be the
alias name found in the AKR.

menu
A list of available commands in an application window. Menu names appear in the menu
bar of the application window.

menu bar
A bar that contains the menus available for your use.

message box
A box that displays a message (error or otherwise) to inform the user of a particular
condition.

Multipurpose Internet Mail Extension (MIME)
The Internet standard for mail that supports text, images, audio, and video.

NCSA Mosaic
A web browser available on multiple platforms.

online help
See "help" on page 59.

Online Transaction Processing (OLTP)

A style of computing that supports interactive applications in which requests submitted
by terminal users are processed as soon as they are received. Results are returned to the
requester in a relatively short period of time. An online transaction processing system
supervises the sharing of resources to allow efficient processing of multiple transactions
at the same time.

paragraph name
Any PROCEDURE DIVISION paragraph or section name, and the PROCEDURE and
PROC literals. Paragraph name includes the entire paragraph or section.

partial statement

In a generated COBOL module, a statement that was modified to omit certain datanames
or file names that are not required for that statement in the generated module. The partial
statement contains only that portion of the statement required for the generated module.
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perform range

A perform range consists of the source code contained in a PERFORM statement, and
includes all code that is or could be executed as a result of GO TOs, PERFORMs, etc.
within that PERFORM.

perform range extract

The process of isolating all executable statements of a perform range. This includes not
only the statements within the range, but also all code that is reachable using GO TO or
PERFORM from within the range.

Pop-up

A window that appears as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to allow entry
of information for the requested action.

postscript
The standard for presenting text and graphics in a device-independent format.

primary command
An instruction entered in the command input area of the screen.

program
Program source member name, the name specified in the IDENTIFICATION DIVISION
of a COBOL program, or the CSECT name of a program that is not COBOL.

protocol
. A formal set of conventions governing the format and control of data.

* A set of procedures or rules for establishing and controlling transmissions from a
source device or process to a target device or process.

proxy
A gateway that allows Web browsers to pass on a network request (a URL) to an outside
agent.

pseudo conversational
A type of CICS application design that appears to the user as a continuous conversation,
but consists internally of multiple tasks.

pull-down

The list that appears when an action is selected on the action bar. On a pull-down, an
action followed by ellipses (...) displays a pop-up when selected and an action not
followed by ellipsis (...) immediately activates internal commands.

punch file
The file that is allocated when a request to punch is issued.
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recovery
The use of archived copies to reconstruct files, databases, or complete disk images after
they are lost or destroyed.

recoverable resources
Items whose integrity CICS maintains in the event of a system error. These include
individual files and queues.

recursion
A perform range or paragraph that performs itself.

re-engineering

The process of renovating an existing program to isolate and extract distinct functions.
Encore can isolate and extract code based on a perform range, report, computation
variable, transaction, or server.

report extract

The process of isolating all WRITE/GENERATE statements for a specific File
Description (FD) or Report Description (RD). Individual statements may be selected. The
extracted unit consists of the statements required to produce the WRITE/GENERATE
statement(s).

SBCS
See "Single Byte Character Set - (SBCS)" on page 64.

screen
A full-width display of information containing an action bar as the first line. Encore
screens are modeled after TSO/ISPF screens.

screen subset
The result of an interactive command.

script
An executable program invoked by HTTP servers.

script file
A dataset containing Encore commands, created when SET SCRIPT is ON, and executed
with the EXECUTE primary command or the File » Execute script pull-down option.

server

Any computing resource dedicated to responding to client requests. Servers can be linked
to clients through LANs and WANS to perform services (such as printing, database
access, fax, and image processing) on behalf of multiple clients at the same time.

server extract

Process used to create a COMMAREA-based server program from a 3270 CICS
pseudo-conversational program.
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shortcut key
A keyboard key or combination of keys that invokes a particular command, such as
CNTL + N.

short message

A diagnostic or error message that is displayed in the upper right corner of Encore
screens. Pressing PF1/PF13 (HELP) after receiving a short message displays the
corresponding long message.

Single Byte Character Set - (SBCS)

A character set that uses one byte to represent each character. Single Byte Character Sets
are used with languages, such as English, where the characters can be represented with a
one-byte code.

Socket Secure (SOCKS)
The gateway that allows compliant client code (client code made socket secure) to
establish a session with a remote host.

Standard Generalized Markup Language (SGML)
The standard that defines several markup languages, HTML included.

statement extract
The process of isolating all user-identified statements from a program.

status bar
The area at the bottom of a main window that lists the status of an action and gives other
information, such as the meaning of a command.

Storage Management Subsystem (SMS)

An operating environment that automates and centralizes the management of storage. To
manage storage, SMS provides the storage administrator with control over data class,
storage class, management class, storage group, and ACS routine definitions.

subset
A grouping of source lines in a program. See "COBOL subset" on page 55, "screen
subset" on page 63, and "tagged line subset" on page 65 .

synchronous

. Pertaining to two or more processes that depend on the occurrence of a specific
event such as a common timing signal.

. Occurring with a regular or predictable time relationship.
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synchpoint

A logical point in execution of an application program where the changes made to the
databases by the program are consistent and complete and can be committed to the
database. The output, which was held up to that point, is sent to its destination. The input
is removed from the message queues and the database updates are made available to other
applications. When a program terminates abnormally, CICS recovery and restart facilities
do not back out updates prior to the last completed synchpoint.

tagged line subset
Command results displayed in columns 73 through 80 of the Source View screen.

target
The object of a primary command.

transaction

A unit of processing (consisting of one or more application programs) initiated by a
single request. A transaction can require the initiation of one or more tasks for its
execution.

transaction extract

The process of isolating all conditional statements for a specific transaction control
variable. Certain program paths may then be selected or blocked, based on the transaction
code value.

transaction processing

A style of computing that supports interactive applications in which requests submitted
by users are processed as soon as they are received. Results are returned to the requester
in a relatively short period of time. A transaction processing system supervises the
sharing of resources for processing multiple transactions at the same time.

transaction routing

Enables a terminal connected to one CICS system to run a transaction in another CICS
system. It is common for CICS/ESA, CICS/VSE, and CICS/MVS users to have a
terminal-owning region (TOR) that owns end-user network resources.

VIASUB
An edit macro included with Encore that is used to submit an Analyze job.

VIASUBDS
A CLIST included with Encore that is used to submit an Analyze job.
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view method
The manner in which a program is examined in the View facility. These are the three
view methods based on source code:

. Structure view
. Tree view

. Source view
All three views are available concurrently when a program is examined.

work file
A temporary file allocated upon entry to Encore.
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Encore CNTL and CLIST Members

Encore CNTL Members

This table contains Encore CNTL members.

Member Description

VIA$SPRMA

The Encore specific default installation options.

VIASRLSA

Backup of VIASPRMA.

VIARANOM

COBOL demonstration program source for anomaly reporting and
repair.

VIARCBSK

Generated module header box template.

VIAACMPI1

JCL to compile and analyze VIARDEMO demonstration program.
Requires a COBOL II Release 3 or newer compiler.

VIAACMP2

JCL to compile and analyze VIARDRIV and VIARSVBR
demonstration programs. Requires a COBOL II Release 3 or newer
compiler.

VIAACMP3

JCL to compile and analyze VIARANOM demonstration
programs. Requires a COBOL II Release 3 or newer compiler.

VIAACMP4

JCL to compile and analyze VIARBRWS demonstration programs.
Requires a COBOL II Release 3 or newer compiler.

VIARBRWC

Copybook for CICS demonstration program source.

VIARBRWS

CICS demonstration program source.

VIARBRW

Map for CICS demonstration program Main menu panel.

VIARCPY1

COBOL demonstration program copy member.
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Member Description

VIARCPY2 COBOL demonstration program copy member.

VIARCSFP Description of COBOL/SF library+ allocations.

VIARDEMO COBOL demonstration program source.

VIARDRIV COBOL demonstration program source.

VIARIOBK PARM block used to communicate with an IO module.

VIARIOFC 10 module function code constants.
VIARIOSK Generated COBOL program template.
VIARMNU Map for CICS demonstration program Browse menu panel.

VIARMNUC Copybook for CICS demonstration program Browse menu panel.

VIARNTSK Generated COBOL program message template.

VIARSUBR COBOL demonstration program source.

Encore CLIST Members

68

This table contains Encore CLIST members.

Member Description

ENCORE Invokes the Encore product from the ISPF panel.
VIAACSF Invokes the COBOL/SF ECFSTART command.
VIAACSFI CLIST for COBOL/SF to Encore interface.
VIACSTM CLIST for customizing Encore.

VIAENC Invokes the Encore product.

VIAATEST CLIST to establish a TSO test session with Encore.
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DSN 21
GTD 20
HEADER 21
IPR 20
MEM 21
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PARM 20
VIAANOMF 20
anomaly report parameters
NUMPRMA##) 20
RPTCEN 20
VIARERPT 20
VIARERPTAN 20
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Bridge
accessing from ESW screen ix
description vi
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CENTER parameter 8, 11-12
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CICS parameter 9
CICS server
CICS EXEC 41
CICS server endpoints 42
CICS server paths 43

CICS server startpoints 42
copy member field 44
CREATE command 47
endpoints 41
level number increment 44
self-directed server name 41
starting level number 44
statement extract 43

CICS server extract 55
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CICS server extract - EXEC CICS SEND 43

CICS server extracts 4

CICSCOB parameter 9

CICSLIB parameter 9
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CLIST member
ENCORE 14, 68
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VIAACMP4 20, 67
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VIARIOSK 68
VIARNTSK 68
VIARSUBR 68
VIASLPAJ 11
VIASLPX]J 11
COBCOMP parameter 8
COBOL 5
COBOL/SF, interfacing with Encore 13
common code extract 55
compile and link JCL
VIARANOM program 20
VIARBRWS program 20
VIARDEMO program 20
VIARDRIV program 20
VIARSUBR program 20
compilers
COBOL D, E,and F 5
COBOL for MVS and VM 5
COBOL for 0OS/390 and VM 5
COBOLII 5
COBOL/370 5
Object Oriented conditions not
supported 5
COMPILR parameter 8
complement extract 56
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conventions page Xiii
customizing, module header template 13

D

DB2, validation 36

demonstration programs
VIARANOM 8
VIARBRWS 8
VIARDEMO 8
VIARDRIV 8
VIARSUBR 8

E
Encore
accessing from ESW screen ix
description vii
functional components 2
invoking from ISPF 14
invoking with CLIST 14
invoking with TSO VIAENC
CLIST 14
migration 4
ENCORE CLIST member 14, 68
Encore installation
CENTER parameter 8
CICS parameter 9
CICSCOB parameter 9
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CNTL member VIAACMP2 8§
CNTL member VIAACMP3 8
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SYSDA parameter 8
SYSOUT parameter 8
TRNPARM parameter 9
UNIQUE 18
validating parameter definitions 15
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VIA$PRMA modification 9
VIAACMP3 parameters 9
VIAACMP4 parameters 9
VIAACSF CLIST member 13
VIASOFT parameter 8
environment
client - Windows 95/98/2000 5
client - Windows NT with access to
MVS 5
host - 3270 type terminals 5
host - BATCH region size 5
host - Direct Access storage 5
host - MVS ISPF 5
host - MVS/XA, MVS/ESA, or
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host - TSO logon region size 5
host - VSAM 5
platform and software requirements 5
server - OS/390 5
Estimate
accessing from ESW screen ix
description vii
ESW
description v
invoking products viii
product integration ix

|

IDMS, validation 35

Insight
accessing from ESW screen ix
description vii
using analysis functions ix
working with 23
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Librarian customization
ASMBLR parameter 12
CENTER parameter 12
customized edit panel 12
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LIBRLIB parameter 12
LIBRMAC parameter 12
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SYSDA parameter 12
SYSOUT parameter 12
VIALLIB 13
VIASFAIIM module 12
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VIASFAIR module 12
VIASOFT parameter 12
VSPEDLIB panel 12
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menu option, ISPF 14

MLPA
adding Encore modules 10
improving performance 10
staging library 11
VIARCMMP module addition 10
VIARCSFI module addition 10
VIARCSFM module addition 10
VIARCSOM module addition 10
VIARICSF module addition 10
VIARISPP module addition 10
VIARWKSP module addition 10
VIASLPXJ CNTL member 11
VIAZBTCH module addition 10
VIAZCMDP module addition 10
VIAZGENP module addition 10
VIAZPRIP module addition 10
VIAZTBLP module addition 10
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NEWAPPL parameter 14
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overview
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Panvalet customization
ASMBLR parameter 11
CENTER parameter 11
customized edit panel 11
ISPLLIB 12
LIBDEF 12
LIBDEF facility 12
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PANLIB parameter 11
SYSDA parameter 11
SYSOUT parameter 11
VIALLIB 12
VIASOFT parameter 11
VIASPAM module 11
VIASPAMJ CNTL member 11
VSPEDPAN panel 11
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parameter, UNIQUE 18

perform range extract 62

PLPA
adding Encore modules 10
improving performance 10
staging library 11
VIAENC module addition 10
VIARCMMP module addition 10
VIARCSFI module addition 10
VIARCSFM module addition 10
VIARCSOM module addition 10
VIARICSF module addition 10
VIARISPP module addition 10
VIARWKSP module addition 10
VIASLPAJ CNTL member 11
VIASLPXJ CNTL member 11
VIAZBTCH module addition 10
VIAZCMDP module addition 10
VIAZGENP module addition 10
VIAZPRIP module addition 10
VIAZTBLP module addition 10
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Recap
accessing from ESW screen ix
description vii
report extract
description 63
extracting the objective 40
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server extract 63

SmartDoc
accessing from ESW screen ix
description vii

SmartEdit
accessing from ESW screen ix
description viii

SmartQuest
accessing from ESW screen ix
description viii

SmartTest
accessing from ESW screen ix
description viii

statement extract 64

SYSDA parameter 8

SYSOUT parameter 8

T
target generation, overview 4
transaction extract 65
TRNPARM parameter 9

U
UNIQUE parameter 18
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VIASPRMA CNTL member 67
VIASRLSA CNTL member 67
VIAACMP1 CNTL member 8,20, 67
VIAACMP2 CNTL member 8,20, 67
VIAACMP3 CNTL member 8, 20, 67
VIAACMP4 CNTL member 8, 20, 67
VIAACSF CLIST member 68
VIAACSF CNTL member 13
VIAACSFI CLIST member 68
VIAATEST CLIST member 68
VIACSTM CLIST member 68
VIAENC CLIST member 14, 68
VIARANOM CNTL member 67
VIARANOM demonstration program 8
VIARBRW CNTL member 67
VIARBRWC CNTL member 67
VIARBRWS CICS demonstration
program §

VIARBRWS CNTL member 67
VIARCBSK CNTL member 67
VIARCPY1 CNTL member 67
VIARCPY2 CNTL member 68
VIARCSFP CNTL member 13, 68
VIARDEMO CNTL member 68
VIARDEMO demonstration program 8
VIARDRIV CNTL member 68
VIARDRIV demonstration program 8
VIARIOBK CNTL member 68
VIARIOFC CNTL member 68
VIARIOSK CNTL member 68
VIARNTSK CNTL member 68
VIARSUBR CNTL member 68
VIARSUBR demonstration program 8
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VIASOFT parameter 8






ASG Worldwide Headquarters Naples Florida USA | asg.com



	CD Contents
	Contents
	Index
	A
	B
	C
	D
	E
	I
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V

	Publication Conventions
	ASG Customer Support
	Intelligent Support Portal (ISP)
	Telephone Support

	ASG Documentation/Product Enhancements
	Preface
	About this Publication
	Related Publications
	ASG-Existing Systems Workbench (ASG-ESW)
	Invoking ESW Products
	ESW Product Integration
	Example 1
	Example 2


	Introduction
	ASG Service Pack
	Encore Overview
	Encore Components

	Operating Environment
	Environment
	COBOL Compilers
	Preprocessor Support


	Customization
	Prerequisite
	Step 1 - Modifying CNTL Library Members
	Step 2 - Adding Encore Modules to MLPA/PLPA
	Step 3 - Customizing Panvalet or Librarian
	Panvalet Customization
	Librarian Customization

	Step 4 - Customizing the Module Header Box
	Step 5 - Setting up the Encore/COBOL/SF Interface
	Step 6 - Invoking Encore
	To invoke Encore from an ISPF panel
	To invoke Encore using a CLIST

	Step 7 - Validating Encore

	Glossary
	Appendix A - Encore CNTL Members
	Encore CNTL Members
	Encore CLIST Members




